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1 Introduction

1.1 Purpose of the Operating Instructions

The purpose of these operating instructions is to describe
the VLT® Integrated Servo Drive ISD® 510 System.

These operating instructions contain information about:
• Installation

• Commissioning

• Programming

• Operation

• Troubleshooting

• Service and maintenance

These operating instructions are intended for use by
qualified personnel. Read it in full to use the ISD 510 servo
system safely and professionally, and pay particular
attention to the safety instructions and general warnings.
These operating instructions are an integral part of the ISD
510 servo system and also contains important service
information. Therefore, keep it available with the ISD 510
servo system at all times.

Compliance with the information in these operating
instructions is a prerequisite for:

• Trouble-free operation.

• Recognition of product liability claims.

Therefore, read these operating instructions before working
with the ISD 510 servo system.

1.2 Additional Resources

Available manuals for the ISD 510 servo system:

Document Contents

VLT® Integrated Servo Drive

ISD® 510 System Operating
Instructions

Information about the installation,
commissioning, and operation of
the ISD 510 servo system.

VLT® Integrated Servo Drive

ISD® 510 System Design
Guide

Information about the set-up of
the ISD 510 servo system and
detailed technical data.

VLT® Integrated Servo Drive

ISD® 510 System
Programming Guide

Information about the
programming of the ISD 510 servo
system.

Table 1.1 Available Documents for the ISD 510 Servo System

Technical literature for Danfoss drives is also available
online at vlt-drives.danfoss.com/Support/Technical-Documen-
tation/.

1.3 Copyright

VLT®, ISD®, and SAB® are Danfoss registered trademarks.

1.4 Approvals and Certifications

The ISD 510 servo system fulfills the standards listed in
Table 1.2.

IEC/EN 61800-3 Adjustable speed electrical power drive
systems.
Part 3: EMC requirements and specific test
methods.

IEC/EN
61800-5-1

Adjustable speed electrical power drive
systems.
Part 5-1: Safety requirements - Electrical,
thermal and energy.

IEC/EN
61800-5-2

Adjustable speed electrical power drive
systems.
Part 5-2: Safety requirements - Functional.

IEC/EN 61508 Functional safety of electrical/electronical/
programmable electronic safety-related
systems.

EN ISO 13849-1 Safety of machinery - Safety-related parts of
control systems.
Part 1: General principles for design.

EN ISO 13849-2 Safety of machinery - Safety-related parts of
control systems.
Part 2: Validation.

IEC/EN 60204-1 Safety of machinery - Electrical equipment of
machines.
Part 1: General requirements.

IEC/EN 62061 Safety of machinery - Functional safety of
safety-related electrical, electronic, and
programmable electronic control systems.

IEC/EN
61326-3-1

Electrical equipment for measurement, control,
and laboratory use – EMC requirements.
Part 3-1: Immunity requirements for safety-
related systems and for equipment intended
to perform safety-related functions (functional
safety) – General industrial applications.

UL508C UL Standard for Safety for Power Conversion
Equipment.

2006/42/EC Machinery Directive

CE

2014/30/EU EMC Directive

2014/35/EU Low Voltage Directive

RoHS
(2002/95/EC)

Restriction of hazardous substances.
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EtherCAT® Ethernet for Control Automation Technology.
Ethernet-based fieldbus system (see
chapter 12.1 Glossary for further information).

Ethernet

POWERLINK®
Ethernet-based fieldbus system:

PLCopen® Technical specification.
Function blocks for motion control (formerly
Part 1 and Part 2) Version 2.0 March 17, 2011.

Table 1.2 Approvals and Certifications

1.5 System Overview
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Illustration 1.1 Overview of the ISD 510 Servo System

The servo drives are self-contained distributed drives,
whereby the drive electronics is housed together with the
motor in the same casing. There are 2 versions of the
ISD 510 servo drive:

Standard With 2 hybrid connectors (M23) that connect power
and communication signals from a hybrid cable.

Advanced As standard plus 3 additional interfaces for external
encoder or I/Os, fieldbus devices, and for the local
control panel (LCP) to be connected directly.

Table 1.3 ISD 510 Servo Drive Versions

In this decentral system, the servo drives are operated in a
DC group and controlled by a PLC. The motion control
software runs independently in the servo drive, reducing
the load on the PLC.
The ISD 510 servo system requires hybrid cables that
contain the DC supply voltage, the Real-Time Ethernet,
UAUX, and STO signals.
The Servo Access Box (SAB®) is the central power supply
for the ISD 510 servo system.

The ISD 510 servo system is designed to accommodate up
to 64 ISD 510 servo drives and consists of:

• ISD 510 servo drives

• Servo Access Box (SAB)

• 1 PLC (not included)

• Cabling

• Blind caps

• Software:
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- Firmware for the servo drive

- Firmware for the SAB

- PC software tool: ISD Toolbox

- PLC libraries

• Danfoss Motion library for VLT®

Integrated Servo Drive ISD 510
system for AutomationStudio™

• Danfoss Motion library for VLT®

Integrated Servo Drive ISD 510
system for TwinCAT® 2

NOTICE
The ISD 510 servo drives cannot be used in servo
systems from other manufacturers without changing the
cabling infrastructure. Contact Danfoss for further
information.
Drives from other manufacturers cannot be used in the
ISD 510 servo system when using Danfoss hybrid cables.

1.5.1 Areas of Application

Potential areas of application are:
• Food and beverage machines

• Packaging machines

• Pharmaceutical machines

• Applications running with a group of decentral
servo drives.

1.6 Software

Updates to the firmware, ISD Toolbox software, and PLC
libraries may be available. When updates are available,
they can be downloaded from the danfoss.com website.
The ISD Toolbox software or the PLC libraries can be used
to install the firmware on the servo drives or on the SAB.

1.7 Terminology

ISD Integrated servo drive

ISD 510 Servo
Drive

Decentral servo drive

VLT® Servo Access
Box (SAB)

Unit that generates the DC-link voltage and
passes the UAUX,  Real-Time Ethernet, and STO
signals to the ISD 510 servo drives via a
hybrid cable.

PLC External device for controlling the ISD 510
servo system.

Loop cable Hybrid cable for connecting drives in daisy-
chain format.

Feed-in cable Hybrid cable for connection from the SAB to
the 1st servo drive.

Table 1.4 Terminology

An explanation of all terminology and abbreviations can be
found in chapter 12.1 Glossary.

Introduction VLT® Integrated Servo Drive ISD® 510 System
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2 Safety

2.1 Symbols Used in this Manual

The following symbols are used in this manual:

WARNING
Indicates a potentially hazardous situation that could
result in death or serious injury.

CAUTION
Indicates a potentially hazardous situation that could
result in minor or moderate injury. It can also be used to
alert against unsafe practices.

NOTICE
Indicates important information, including situations that
can result in damage to equipment or property.

2.2 General

The following safety instructions and precautions relate to
the ISD 510 servo system.
Read the safety instructions carefully before starting to
work in any way with the ISD 510 servo system or its
components.
Pay particular attention to the safety instructions in the
relevant sections of this manual.

WARNING
HAZARDOUS SITUATION
If the servo drive, SAB, or the bus lines are incorrectly
connected, there is a risk of death, serious injury, or
damage to the unit.
Always comply with the instructions in this manual and
national and local safety regulations.

2.3 Safety Instructions and Precautions

Compliance with the safety instructions and precautions is
necessary at all times.

• Orderly and proper transport, storage, fitting, and
installation, as well as careful operation and
maintenance, are essential for the trouble-free
and safe operation of the ISD 510 servo system
and its components.

• Only suitably trained and qualified personnel may
work on the ISD 510 servo system and its
components or in its vicinity. See
chapter 2.5 Qualified Personnel.

• Only use accessories and spare parts approved by
Danfoss.

• Comply with the specified ambient conditions.
For further information, see chapter 11.1.5 General
Specifications and Environmental Conditions and
chapter 11.2.4 General Specifications and Environ-
mental Conditions.

• The information in this manual about the use of
available components is provided solely by way
of examples of applications and suggestions.

• The plant engineer or system engineer is
personally responsible for checking the suitability
of the supplied components and the information
provided in this manual for the specific
application concerned:

- For compliance with the safety
regulations and standards relevant to
the specific application.

- For implementing the necessary
measures, changes, and extensions.

• Commissioning the ISD 510 servo system or its
components is not allowed until it has been
ascertained that the machine, system, or plant in
which they are installed conforms to the statutory
provisions, safety regulations, and standards that
apply to the application in the country of use.

• Operation is only allowed in compliance with the
national EMC regulations for the application
concerned.

• Compliance with the limit values specified by
national regulations is the responsibility of the
producer of the plant, system, or machine.

• Compliance with the specifications, connection
conditions, and installation conditions in this
manual is mandatory.

• The safety regulations and safety provisions of
the country in which the equipment is used must
be observed.

• To protect the user against electrical shock and to
protect the servo drive and the SAB against
overload, protective grounding is obligatory and
must be performed in accordance with local and
national regulations.

Safety Operating Instructions
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WARNING
GROUNDING HAZARD
The ground leakage current is >3.5 mA. Improper
grounding of the ISD 510 servo system components may
result in death or serious injury.

• For reasons of operator safety, ground the
components of the ISD 510 servo system
correctly in accordance with national or local
electrical regulations and the information in this
manual.

Operational safety
• Safety-related applications are only allowed if

they are explicitly and unambiguously mentioned
in this manual.

• All applications that can cause hazards to people
or damage to property are safety-related
applications.

• The stop functions implemented in the software
of the PLC do not interrupt the mains supply to
the SAB. Therefore, they must not be used as
safety switches for the ISD 510 servo system.

• The servo drive can be brought to a stop by a
software command or a zero speed setpoint,
however DC voltage remains present on the servo
drive and/or mains voltage in the SAB. Also when
the servo drive is stopped, it may start up again
on its own if the circuitry of the servo drive is
defective or after the elimination of a temporary
overload, a problem with the supply voltage, or a
problem with the servo drive. If personal safety
considerations (for example, risk of personal
injury caused by contact with moving machine
parts after an unintended start) make it necessary
to ensure that an unintended start cannot occur,
these stop functions are not sufficient. In this
case, ensure that the ISD 510 servo system is
detached from the mains network, or that a
suitable stop function is implemented.

• The servo drive may start running unintentionally
during parameter configuration or programming.
If this poses a risk to personal safety (for example,
risk of personal injury due to contact with
moving machine parts), prevent unintended
motor starting, for example by using the Safe
Torque Off function, or by safe disconnection of
the servo drives.

• In addition to the L1, L2, and L3 supply voltage
inputs on the SAB, the ISD 510 servo system has
other supply voltage inputs, including external
auxiliary voltage. Before commencing repair work,
check that all supply voltage inputs have been
switched off and that the necessary discharge
time for the DC-link capacitors has elapsed (see

the discharge safety warning in
chapter 2.4 Important Safety Warnings).

2.4 Important Safety Warnings

WARNING
HIGH VOLTAGE
The ISD 510 servo system contains components that
operate at high voltage when connected to the electrical
supply network.
A hazardous voltage is present on the servo drives and
the SAB whenever they are connected to the mains
network.
There are no indicators on the servo drive or SAB that
indicate the presence of mains supply.
Incorrect installation, commissioning, or maintenance can
lead to death or serious injury.

• Installation, commissioning, and maintenance
may only be performed by qualified personnel
(see chapter 2.5 Qualified Personnel).

WARNING
UNINTENDED START
The ISD 510 servo system contains servo drives and the
SAB that are connected to the electrical supply network
and can start running at any time. This may be caused
by a fieldbus command, a reference signal, or clearing a
fault condition. Servo drives and all connected devices
must be in good operating condition. A deficient
operating condition may lead to death, serious injury,
damage to equipment, or other material damage when
the unit is connected to the electrical supply network.

• Take suitable measures to prevent unintended
starts.

WARNING
DISCHARGE TIME
The servo drives and the SAB contain DC-link capacitors
that remain charged for some time after the mains
supply is switched off at the SAB. Failure to wait the
specified time after power has been removed before
performing service or repair work could result in death
or serious injury.

• To avoid electrical shock, fully disconnect the
SAB from the mains and wait for at least the
time listed in Table 2.1 for the capacitors to fully
discharge before carrying out any maintenance
or repair work on the ISD 510 servo system or
its components.

Safety VLT® Integrated Servo Drive ISD® 510 System
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Number Minimum waiting time (minutes)

0–64 servo drives 10 

Table 2.1 Discharge Time

NOTICE
Never connect or disconnect the hybrid cable to or from
the servo drive when the ISD 510 servo system is
connected to mains or auxiliary supply, or when voltage
is still present. Doing so damages the electronic circuitry.
Ensure that the mains supply is disconnected and the
required discharge time for the DC-link capacitors has
elapsed before disconnecting or connecting the hybrid
cables or disconnecting cables from the SAB.

2.5 Qualified Personnel

Installation, commissioning, and maintenance of the
ISD 510 servo system may only be carried out by qualified
personnel.
For the purposes of this manual and the safety instructions
in this manual, qualified personnel are trained personnel
who are authorized to fit, install, commission, ground, and
label equipment, systems, and circuits in accordance with
the standards for safety technology and who are familiar
with the safety concepts of automation engineering.
Additionally, the personnel must be familiar with all the
instructions and safety measures described in this manual.
They must have suitable safety equipment and be trained
in first aid.

2.6 Due Diligence

The operator and/or fabricator must ensure that:

• The ISD 510 servo system and its components are
used only as intended.

• The components are operated only in a perfect
operational condition.

• The operating instructions are always available
near the ISD 510 servo system in complete and
readable form.

• The ISD 510 servo system and its components are
fitted, installed, commissioned, and maintained
only by adequately qualified and authorized
personnel.

• These personnel are regularly instructed on all
relevant matters of occupational safety and
environmental protection, as well as the contents
of the operating instructions and the instructions
it contains.

• The product markings and identification markings
applied to the components, as well as safety and
warning instructions, are not removed and are
always kept in a legible condition.

• The national and international regulations
regarding the control of machinery and
equipment, that are applicable at the place of use
of the ISD 510 servo system, are complied with.

• The users always have all current information
relevant to their interests about the ISD 510 servo
system and its use and operation.

2.7 Intended Use

The components of the ISD 510 servo system are intended
to be installed in machines used in industrial environments
in accordance with local laws and standards.

NOTICE
In a domestic environment, this product may cause radio
interferences, in which case supplementary mitigation
measures may be required.

To ensure that the product is used as intended, the
following conditions must be fulfilled before use:

• Everyone who uses Danfoss products in any
manner must read and understand the
corresponding safety regulations and the
description of the intended use.

• Hardware must be left in its original state.

• Software products must not be reverse-
engineered and their source code must not be
altered.

• Damaged or faulty products must not be installed
or put into operation.

• It must be ensured that the products are installed
in conformance with the regulations mentioned
in the documentation.

• Any specified maintenance and service intervals
must be observed.

• All protective measures must be complied with.

• Only the components described in these
operating instructions may be fitted or installed.
Third-party devices and equipment may be used
only in consultation with Danfoss.

The ISD 510 servo system may not be used in the
following application areas:

• Areas with potentially explosive atmospheres.

• Mobile or portable systems.

• Floating or airborne systems.

• Inhabited facilities.

• Sites where radioactive materials are present.

Safety Operating Instructions
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• Areas with extreme temperature variations or in
which the maximum rated temperatures may be
exceeded.

• Under water.

2.8 Foreseeable Misuse

Any use not expressly approved by Danfoss constitutes
misuse. This also applies to failure to comply with the
specified operating conditions and applications.
Danfoss assumes no liability of any sort for damage attrib-
utable to improper use.

2.9 Service and Support

Contact the local service representative for service and
support:
vlt-drives.danfoss.com/Support/Service/

Safety VLT® Integrated Servo Drive ISD® 510 System
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3 System Description

3.1 Overview

The VLT® Integrated Servo Drive ISD® 510 system is a high-
performance decentral servo motion solution.

It comprises:
• A central power supply VLT® Servo Access Box

(SAB®).

• VLT® Integrated Servo Drives ISD® 510.

• Cabling infrastructure.

The decentralization of the drive unit offers benefits in
mounting, installation, and operation. Depending on the
application, the SAB can power up to 64 drives in a servo
drive system when using 2 hybrid lines. It generates a DC-
link voltage of 565–680 V DC ±10% and guarantees high
power density. It has a removable local control panel (LCP),
and is based on the proven quality of a Danfoss frequency
converter.
The motion control is integrated into the servo drive so
that the motion sequences can take place independently.
This reduces the required computing power of the central
PLC and offers a highly flexible drive concept. Danfoss
offers libraries for various IEC 61131-3 programmable PLCs.
Due to the standardized and certified fieldbus interfaces of
the ISD devices, any PLC with an EtherCAT® master
functionality or Ethernet POWERLINK® managing node
functionality according to the standards can be used.
Hybrid cables are used to connect the drives, making
installation fast and simple. These hybrid cables contain
the DC-link supply, the Real-Time Ethernet, UAUX and STO
signals.

3.2 Servo Drive

ISD is the abbreviation of integrated servo drive, which is a
compact drive with an integrated permanent magnet
synchronous motor (PMSM). This means the entire power
drive system consisting of motor, position sensor,
mechanical brake, and also power and control electronics
is integrated into 1 housing. Additional circuits, such as
main low voltage supply, bus drivers, and functional safety
are implemented within the servo drive electronics. All
servo drives have 2 hybrid connectors (M23) that connect
power and communication signals from a hybrid cable. The
advanced version has 3 additional interfaces for external

encoder or I/Os, fieldbus devices, and for the local control
panel (LCP) to be connected directly.

LEDs on the top of the servo drive show the current status
(see chapter 7.2 Operating Status Indicators for further
information). Data transfer takes place via Real-Time
Ethernet.

1

2

13
0B

E3
85

.1
0

1 Operating LEDs (see chapter 7.2.1 Operating LEDs on the Servo
Drive for further information).

2 Connectors

Illustration 3.1 ISD 510 Servo Drive

The ISD 510 servo drive has the following flange sizes:
76 mm, 84 mm.

Further flange sizes of 108 mm and 138 mm are in
planning.

 Size 1,
1.5 Nm

Size 2,
2.1 Nm

Size 2,
2.9 Nm

Size 2,
3.8 Nm

Flange size 76 mm 84 mm

Table 3.1 Motor and Flange Sizes

All dimensions of the servo drive are listed in
chapter 11.1.3 Dimensions.

System Description Operating Instructions
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3.2.1 Servo Drive Types

Pos. 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40

Fixed I S D 5 1 0  T     D 6                           

Variant       A  0 1 C 5   E 5 4 F R X P L S X X T F 0 7 6 S X N 4 6 X S X S X

       S  0 2 C 1   E 6 7 F S 1 E C S C O F F 0 8 4 C 0 N 4 0 B K S C X

         0 2 C 9      F M 1 P N     F 1 0 8   N 2 9  C    

         0 3 C 8         E N     F 1 3 8   N 2 4      

Table 3.2 Type Code

[01–03] Product group  [21–22] Bus system  [33–35] Motor speed
ISD VLT® Integrated Servo Drive  PL Ethernet POWERLINK®  N46 Rated speed 4600 RPM

[04–06] Product variant  EC EtherCAT®  N40 Rated speed 4000 RPM

510 ISD® 510  PN PROFINET®1)  N29 Rated speed 2900 RPM

[07] Hardware configuration  EN Ethernet/IP™1)  N24 Rated speed 2400 RPM

A Advanced  [23–25] Firmware  [36] Mechanical brake
S Standard  SXX Standard  X Without brake
[08] Drive torque  SC0 Customized version  B With brake
T Torque  [26] Safety  [37] Motor shaft
[09–12] Torque  T Safe Torque Off (STO)  S Standard smooth shaft
01C5 1.5 Nm  F Functional safety1)  K Standard fitted key1)

02C1 2.1 Nm  [27–30] Flange size  C Customized
02C9 2.9 Nm  F076 76 mm  [38] Motor sealing
03C8 3.8 Nm  F084 84 mm  X Without sealing
[13–14] DC voltage  F108 108 mm1)  S With sealing

D6 600 V DC-link voltage  F138 138 mm1)  [39–40] Surface coating

[15–17] Drive enclosure  [31–32] Flange type  SX Standard
E54 IP54  SX Standard  CX Customized
E67 IP67 (shaft IP65)  C0 Customized version  
[18–20] Drive feedback       
FRX Resolver     
FS1 Single-turn feedback       
FM1 Multi-turn feedback       

Table 3.3 Legend to Type code

1) In preparation

3.2.2 Motor Components

3.2.2.1 Shaft

The shaft transfers the motor force (torque) to the machine
coupled to the shaft.
The shaft material is C45+C or equivalent according to
EN 10277-2.
The ISD 510 servo drives can be sealed by a shaft seal
(optional) to achieve IP65 on the A-side of the motor (see
chapter 11.1.5 General Specifications and Environmental
Conditions for further information).

3.2.2.2 Brake (Optional)

The optional mechanical holding brake is designed as a
single-disc brake. The emergency stop function can be
initiated at most once every 3 minutes and up to 2000
times in total, depending on the load.

The effective holding torque is:
• Size 1: 2.5 Nm

• Size 2: 5.3 Nm

The brake operates as a holding brake according to the
fail-safe principle closed when no current. It is powered
from the 24–48 V DC auxiliary supply. This enables low-
backlash load holding when no current is present.

Electrical data: Power consumption:
• Size 1: 1.5 W

• Size 2: 1.8 W

System Description VLT® Integrated Servo Drive ISD® 510 System
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NOTICE
Do not misuse the holding brake as a working brake
because this causes increased wear, resulting in
premature failure.

NOTICE
Using servo drives with brakes can reduce the number of
drives allowed, depending on the total length of each
hybrid line. See the shell diagram in the VLT®  Integrated
Servo Drive ISD®  510 System Design Guide for further
information.

3.2.2.3 Cooling

The servo drives are self-cooling.

Cooling (heat dispersal) is primarily via the flange, with a
small amount dispersed by the housing.

3.2.2.4 Thermal Protection

Thermal sensors monitor the maximum allowable
temperature of the motor winding and switch the motor
off if the limit of 140 °C is exceeded. Thermal sensors are
also present in the drive to protect the electronics against
overtemperature. An error message is sent via Real-Time
Ethernet to the higher-level PLC and is also shown on the
LCP.

3.2.2.5 Built-In Feedback Devices

The built-in feedback device measures the rotor position.

There are 3 feedback variants available:
• Resolver

• 17-Bit single-turn encoder

• 17-Bit multi-turn encoder

Table 3.4 summarizes the characteristic data of each
variant.

Data/type Resolver Single-turn
encoder

Multi-turn
encoder

Signal Sin/cos BiSS-B BiSS-B

Accuracy ±10 arc min ±1.6 arc min ±1.6 arc min

Resolution 14 bit 17 bit 17 bit

Maximum
number of
turns

– – 4096 (12 bit)

Table 3.4 Characteristic Data of Available Feedback Devices

3.2.3 Drive Components

3.2.3.1 Connectors on the Servo Drives

This chapter details all possible connections for the
standard and advanced servo drive. Refer to the tables in
this chapter for maximum cable lengths, ratings, and other
limits.

There are 5 connectors on the servo drives.

1
2

3
8 4

56
7

13
0B

E3
86

.1
0

Connector Description

X1 M23 Feed-in or loop hybrid cable input

X2 M23 Loop hybrid cable output or fieldbus
extension cable

X3 (advanced version
only)

M8 Ethernet cable (minimum CAT5,
shielded)

X4 (advanced version
only)

M12 I/O and/or encoder cable (shielded)

X5 (advanced version
only)

M8 LCP cable (shielded)

Illustration 3.2 Connectors on the ISD 510 Servo Drive

System Description Operating Instructions
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X1 and X2: Hybrid connector (M23)
The hybrid cable provides the supply (mains and auxiliary),
the communication lines, and the safety supply for each
line of servo drives. Input and output connectors are
connected inside the servo drive.

13
0B

E3
81

.1
0CB

A

3

7

6

D

PE

2

8

5

Illustration 3.3 X1: Male Hybrid Connector (M23)

BC

AD

PE

2

8

5

3

7

6

13
0B

E3
82

.1
0

Illustration 3.4 X2: Female Connector (M23)

Pin Description Notes Rating/parameter

A UDC– Negative DC mains
supply

Operating voltage:
Negative DC supply
(maximum –15 A)

B UDC+ Positive DC mains
supply

Operating voltage:
Positive DC supply
(maximum 15 A)

C AUX+ Auxiliary supply 24–48 V DC, 15 A
Absolute maximum
55 V DC

D AUX– Auxiliary supply
ground

15 A

PE PE PE connector 15 A

2 STO+ Safety supply 24 V DC ±10%, 1 A

3 STO– Safety supply
ground

1 A

5 TD+ Positive Ethernet
transmit

According to standard
100BASE-T

6 RD+ Positive Ethernet
receive

7 TD– Negative Ethernet
transmit

8 RD– Negative Ethernet
receive

Table 3.5 Pin Assignment of X1 and X2 Hybrid Connectors (M23)

X3: 3rd Ethernet connector (M8, 4 pole)
The ISD 510 advanced servo drive has an additional
fieldbus port (M8) for connecting a device that
communicates via the selected fieldbus.

13
0B

E4
35

.1
0

1

23

4

Pin Description Notes Rating/parameter

1 TD+ Positive Ethernet
transmit

According to standard
100BASE-T

2 RD+ Positive Ethernet
receive

3 TD– Negative Ethernet
transmit

4 RD– Negative Ethernet
receive

Illustration 3.5  Pin Assignment of X3 3rd Ethernet Connector
(M8, 4 pole)

System Description VLT® Integrated Servo Drive ISD® 510 System
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X4: M12 I/O and/or encoder connector (M12, 8-pole)

The M12 I/O and/or encoder connector is available on the
advanced servo drive and can be used or configured as:

• Digital output

• Digital input

• Analog input

• 24 V supply

• External encoder interface (SSI or BiSS).

13
0B

E4
33

.1
0

1 8
2

3

4
56

7

Pin Description Notes Rating/parameter

1 Digital
output

Switched 24 V as
digital output or
supply (24 V/150 mA)

Nominal voltage

24 V ±15%
Maximum current
150 mA
Maximum switching
frequency 100 Hz

2 Ground Ground isolated –

3 Input 1 Analog/Digital input Digital input:
Nominal voltage 0–
24 V

Bandwidth: ≤ 100 kHz
Analog input:
Nominal voltage 0–
10 V
Input impedance

5.46 kΩ
Bandwidth: ≤ 25 kHz

4 /SSI CLK Negative SSI/BiSS
clock out

SSI:
Bus Speed: 0.5 Mbit
with 25 m cable
BiSS:
Fulfills the RS485
specification.
Maximum cable length
(SSI & BiSS): 25 m

5 SSI DAT Positive SSI/BiSS data
in

6 SSI CLK Positive SSI/BiSS clock
out

7 Input 2 Analog/Digital input Digital input:
Nominal voltage 0–
24 V

Bandwidth: ≤ 100 kHz
Analog input:
Nominal voltage 0–
10 V
Input impedance

5.46 kΩ
Bandwidth: ≤ 25 kHz

Pin Description Notes Rating/parameter

8 /SSI DAT Negative SSI/BiSS data
in

SSI:
Bus Speed: 0.5 Mbit
with 25 m cable
BiSS:
Fulfills the RS485
specification.
Maximum cable length
(SSI & BiSS): 25 m

Illustration 3.6 Pin Assignment of X4 M12 I/O and/or Encoder
Connector (M12)

X5: LCP connector (M8, 6 pole)
The X5 connector is used to connect the LCP directly to
the advanced servo drive via a cable.

13
0B

E4
34

.1
0

1
2

3 4

5
6

Pin Description Notes Rating/
parameter

1 Not connected – –

2 /LCP RST Reset Active at
<0.5 V

3 LCP RS485 Positive RS485
signal

Speed:
38.4 kBd
The levels
fulfill the
RS485 specifi-
cation.

4 /LCP RS485 Negative RS485
signal

5 GND GND –

6 VCC 5 V Supply for
LCP

5 V ±10% at
120 mA
maximum load

Illustration 3.7 Pin Assignment of X5 LCP Connector
(M8, 6-pole)

System Description Operating Instructions
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3.3 Servo Access Box (SAB)

The SAB is the power supply and central interface/gateway to the ISD 510 servo system. It guarantees the connection of the
servo drives to the fieldbus, generates the DC-link voltage for the ISD 510 servo system, and delivers a high-density output.
It can be controlled using the local control panel (LCP) or via Ethernet-based fieldbus.
The LEDs on the front of the unit show the operating status and warnings (see chapter 7.2.2 Operating LEDs on the Servo
Access Box for further information).

NOTICE
The SAB has an IP-rating of IP20. It is only designed for use within a control cabinet. The SAB may be damaged if
exposed to fluids.

All power and signal cables are wired into the SAB and 2 independent lines of servo drives can be connected.

Service functions, such as voltage measuring, are performed by the SAB.

1

3 4

2

5

6

7

8

9

10

11

12

13

14

17

16

15

18

192021
2224 2325

26

27

2829

30

33

31

32

13
0B

E3
87

.1
0

Illustration 3.8 Explosion Drawing of the Servo Access Box
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Number Description/connector name Name on
corresponding
connector

Number Description/connector name Name on
corresponding
connector

1 Local control panel (LCP) – 18 Hybrid cable line 2 –

2 Front cover – 19 Decoupling plate –

3 STO 1 IN: STO
(Used for STO input voltage 1)

+STO– 20 Shielded cable grounding
clamp and strain relief

–

4 STO 1 IN: 24 V
(Used for bridging when the STO function
is not required, see chapter 3.3.1.1 STO
Connectors)

+24V– 21 24/48 V IN
(Auxiliary input terminal)

+AUX–

5 LEDs for status of auxiliary output and
STO

– 22 Relay 1 Relay 1

6 Decoupling clamp for STO cable – 23 Relay 2 Relay 2

7 ISD Line 2: STO 2
(STO output to hybrid cable line 2)

+STO– 24 Brake R– (81), R+ (82)

8 ISD Line 2: NET 2 X4
(Ethernet output to hybrid cable line 2)

RJ45 connector
(without label)

25 Mains
(Input terminal)

L1 (91), L2 (92), L3
(93)

9 ISD Line 2: AUX 2
(Auxiliary output to hybrid cable line 2)

+AUX– 26 Decoupling fixture for Ethernet
inputs

–

10 ISD Line 2: UDC 2
(UDC output to hybrid cable line 2)

+UDC– 27 Decoupling clamp for encoder
cable

–

11 ISD Line 1: STO 1
(STO output to hybrid cable line 1)

+STO– 28 X1
(Ethernet input line 1)

RJ45 connector
(not included)

12 ISD Line 1: NET 1 X3
(Ethernet output to hybrid cable line 1)

RJ45 connector
(without label)

29 X2
(Ethernet input line 2)

RJ45 connector
(not included)

13 ISD Line 1: AUX 1
(Auxiliary output to hybrid cable line 1)

+AUX– 30 GND, 24 V, GX, /RS422 TXD,
RS422 TXD, /RS422 RXD, RS422
RXD
(Encoder terminal)

Not labeled

14 ISD Line 1: UDC 1
(UDC output to hybrid cable line 1)

+UDC– 31 STO 2 IN: STO
(Used for STO input voltage 2)

+STO–

15 Grounding PE clamp for hybrid cable line
2

– 32 STO 2 IN: 24 V
(Used for bridging when the
STO function is not required,
see chapter 3.3.1.1 STO
Connectors)

+24V–

16 Grounding PE clamp for hybrid cable line
1

– 33 Cover –

17 Hybrid cable line 1 – – – –

Table 3.6 Legend to Illustration 3.8

3.3.1 Connections on the SAB

All required connectors are included with the SAB.

All cabling must comply with national and local regulations
on cable cross-sections and ambient temperature. Use
shielded/armored cables to comply with EMC emission
specifications.

System Description Operating Instructions
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3.3.1.1 STO Connectors

Item Position
on SAB

Description Drawing/
pins

Ratings

STO
1 IN:
STO

Front Used for STO
input voltage
1.

13
0B

E3
93

.1
0

+ STO –

Pins (left
to right):
STO+
STO-

Nominal voltage:

24 V DC ±10%
Nominal current:
Depends on the
number of servo
drives in the
application.
Maximum current:
1 A
Maximum cross-
section:

1.5 mm2

STO
2 IN:
STO

Front Used for STO
input voltage
2.

STO
1 IN:
24 V

Front These
connectors can
only be used
to make a
bridge to STO
1 IN: STO and
STO 2 IN: STO
if the STO
function is not
required in the
application.
This connector
cannot be
used for any
other function.

13
0B

E3
96

.1
0

+ 24V –

Pins (left
to right):
24+
24-

Nominal voltage:

24 V DC ±10%
Nominal current:
1 A
Maximum cross-
section:

1.5 mm2

STO
2 IN:
24 V

Front

ISD
Line
1:
STO
1

Underside Used for STO
output voltage
1.

13
0B

E3
94

.1
0

+   STO   –

Pins (left
to right):
STO+
STO-

Nominal voltage:

24 V DC ±10%
Nominal current:
Depends on the
number of servo
drives in the
application.
Maximum current:
1 A
Maximum cross-
section:

0.5 mm2

ISD
Line
2:
STO
2

Underside Used for STO
output voltage
2.

Table 3.7 STO Connectors

3.3.1.2 Mains Connectors

Item Description Drawing/
pins

Ratings

AC
mains
supply

Used to connect
L1/L2/L3

13
0B

E3
88

.1
0

L1 L2 L3

Pins (left
to right):
L1
L2
L3

Nominal voltage:
400–480 V AC
Nominal current:
12.5 A
Maximum cross-section:

4 mm2

Mains
PE

The PE screw is
used to connect
the protective
earth, see
Illustration 3.9.

– Cross-section:

10 mm2

See
chapter 5.4 Grounding for
further information.

Table 3.8 Mains Connectors

13
0B

E7
06

.1
0

1

1 PE screw

Illustration 3.9 PE Screw
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3.3.1.3 Brake Connectors

Item Description Drawing/pins Ratings

Brake Used for
connecting a
brake resistor

88 89 81 82

-DC +DC R- R+
13

0B
E3

89
.1

0

–DC (88) = Do not use
+DC (89) = Do not use
R– (81) = Brake –
R+ (82)= Brake +

Nominal
voltage:
565–778 V DC
Maximum brake
current:
14.25 A
Maximum cross-
section:

4 mm2

Table 3.9 Brake Connectors

NOTICE
The maximum length of the brake cable is 20 m
(shielded).

3.3.1.4 Relay Connectors

Item Description Drawing/pins Ratings

Relay
1

Used for a customer-
defined reaction. For
example, the relay
can be triggered if
the SAB issues a
warning.

13
0B

E3
90

.1
0

RELAY 1

Pins (left to
right):
1: Common
2: Normally
open
3: Normally
closed

Pin 1: Common
Pin 2: 240 V AC
Pin 3: 240 V AC
Nominal current:
2 A
Maximum cross-

section: 2.5 mm2

Relay
2

RELAY 2

13
0B

E3
91

.1
0

Pins (left to
right):
4: Common
5: Normally
open
6: Normally
closed

Pin 4: Common
Pin 5: 400 V AC
Pin 6: 240 V AC
Nominal current:
2 A
Maximum cross-

section: 2.5 mm2

Table 3.10 Relay Connectors

3.3.1.5 Encoder Connectors

Item Description Drawing/pins Ratings

Encoder
connector

Used to
connect SSI or
BiSS encoders.

13
0B

E3
92

.1
0

G
N

D

24 V

G
X

RS422 TXD

RS422 TXD

RS422 RXD

RS422 RXD

Pins (left to right
on SAB label):
RS422 RXD
/RS422 RXD
RS422 TXD
/RS422 TXD
GX
24 V
GND

Maximum
cross-
section:

0.5 mm2.
See
Table 3.12.

Table 3.11 Encoder Connectors

NOTICE
The maximum length of the encoder cable is 25 m
(shielded).

Number Description Notes Rating/
parameter

  SSI BiSS  

1 RS422 RXD Positive data Bus speed:
SSI: 0.5 Mbit
with 25 m cable
BiSS: Fulfills the
RS485 specifi-
cation

2 /RS422 RXD Negative data

3 RS422 TXD Positive clock

4 /RS422 TXD Negative clock

5 GX Isolated ground
If encoders are

powered externally, the
ground of the external

supply must be
connected to GX.

–

6 24 V 24 V DC ±10%
(used for powering the

encoder)

Maximum
current:
250 mA

7 GND Ground for pin 6 –

Table 3.12 Pin Assignment for SSI and BiSS Encoders
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3.3.1.6 Ethernet Connectors (not included)

Connector
name

Description Drawing/pins Ratings

Ethernet X1 Connection to
fieldbus 13

0B
E3

95
.1

0

8
1

Pins:
1: TD+
2: TD–
3: RD+
6: RD–

Fulfill the
100BASE-T
specificationEthernet X2 Connection to

fieldbus

Ethernet X3 Connection to
servo line 1

Ethernet X4 Connection to
servo line 2

Table 3.13 Ethernet Connectors

NOTICE
The maximum length of the X1 and X2 shielded Ethernet
cables is 30 m.

3.3.1.7 AUX Connectors

Connector
name

Description Drawing/
pins

Ratings

ISD Line 1:
AUX 1

Used to connect
the AUX output
from the SAB to
the hybrid cable.

13
0B

E3
98

.1
0

+ AUX –

Pins (left to
right):
AUX+
AUX–

Nominal voltage:

24–48 V DC±10%
Nominal current:
Depends on the
number of servo
drives in the
application
Maximum current:
15 A
Maximum cross-

section: 2.5 mm2

ISD Line 2:
AUX 2

Table 3.14 AUX Connectors

3.3.1.8 24/48 V IN Connector

Connector
name

Description Drawing/
pins

Ratings

24/48 V IN
Connector

Used for 24–
48 V DC input
to the SAB.

13
0B

E3
97

.1
0

+   AUX   –

Pins (left to
right):
AUX+
AUX–

Nominal voltage: 24–

48 V DC ±10%
Nominal current:
Depends on the
number of servo
drives in the
application
Maximum current:
34 A
Maximum cross-
section:

4 mm2

Maximum cable
length: 3 m

Table 3.15 24/48 V IN Connector

3.3.1.9 UDC Connectors

Connector
name

Description Drawing/
pins

Ratings

ISD Line 1:
UDC 1

Used to connect
the DC-link
voltage from the
SAB to the
hybrid cable.

13
0B

E3
99

.1
0

+  UDC  –

Pins (left to
right):
UDC+
UDC–

Nominal voltage:
565–778 V DC
Nominal current:
Depends on the
number of servo
drives in the
application
Maximum current:
15 A
Maximum cross-
section:

2.5 mm2

ISD Line 2:
UDC 2

Table 3.16 UDC Connectors

3.3.1.10 Hybrid Cable PE

Item Description Drawing/pins Ratings

Hybrid
cable PE

Used to connect the
PE wire from the
hybrid cable to the
decoupling plate.

See callout 15 in
Illustration 3.8.

Maximum
cross-
section:

2.5 mm2

Table 3.17 Hybrid Cable PE
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3.4 Local Control Panel (LCP)

3.4.1 Overview

The LCP is the graphical user interface on the SAB for
diagnostic and operating purposes. It is included as
standard with the SAB but can also be connected to the
advanced version servo drives using an optional cable
(M8 to LCP D-SUB extension cable).

The LCP display provides the operator with a quick view of
the state of the servo drive or SAB, depending on which
device it is connected to. The display shows parameters
and alarms/errors and can be used for commissioning and
troubleshooting. It can also be used to perform simple
functions, for example activating and deactivating the
output lines on the SAB. The LCP can be mounted on the
front of the control cabinet and then connected to the SAB
via SUB-D cables (available as an accessory).

3.4.2 Local Control Panel (LCP) Layout

The local control panel is divided into 4 functional groups
(see Illustration 3.10).

A. Display area.

B. Display menu keys.

C. Navigation keys and indicator lights (LEDs).

D. Operation keys and reset.

A. Display area
The values in the display area differ depending on whether
the LCP is connected to an ISD 510 servo drive or the SAB
as shown in Illustration 3.10 and Illustration 3.11.

The display area is activated when the ISD 510 servo drive
or SAB it is connected to receives power from the mains
supply, a DC bus terminal, or UAUX.

13
0B

E6
92

.1
1

Auto
on

ResetHand
on

O�

Status Quick
Menu

Main
Menu

Alarm
Log

Back

Cancel
InfoOK

Status
271°

2850 RPM

On

Alarm

Warn.

A

38 °C3.1 Nm

B

C

D

1.8 A

1

2

3

4

5

6

7
8

9

10

11

12

13

14

15

16

17

18 19 20 21

Display Description

1 Actual torque

2 Temperature drive module

3 Position

4 Speed

5 Current

Illustration 3.10 Display Area when Connected to an ISD 510
Servo Drive
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13
0B

E6
93

.1
1

Auto
on

ResetHand
on

O�

Status Quick
Menu

Main
Menu

Alarm
Log

Back

Cancel
InfoOK

Status
11.5 A

2.1 kW

On

Alarm

Warn.

A

38 °C24 V

B

C

D

565 V

1

2

3

4

5

6

7
8

9

10

11

12

13

14

15

16

17

18 19 20 21

Display Description

1 UAUX line voltage

2 Temperature

3 Actual UDC (current)

4 ISD power consumption

5 Actual UDC (voltage)

Illustration 3.11 Display Area when Connected to the SAB

B. Display menu keys
Menu keys are used for menu access for parameter set-up,
toggling through status display modes during normal
operation, and viewing fault log data.

 Key Function

6 Status Shows operational information.

7 Quick Menu Allows access to parameters.

8 Main Menu Allows access to parameters.

9 Alarm Log Shows the last 10 alarms.

Table 3.18  Display Menu Keys

C. Navigation keys and indicator lights (LEDs)
Navigation keys are used for moving the display cursor
and provide operation control in local operation. There are
also 3 status LEDs in this area.

 Key Function

10 Back Reverts to the previous step or list in the
menu structure.

11 Cancel Cancels the last change or command as long
as the display mode is not changed.

12 Info Press for a definition of the function being
shown.

13 Navigation
keys

Use the 4 navigation keys to move between
items in the menu.

14 OK Use to access parameter groups or to enable
a selection.

Table 3.19 Navigation Keys

 LED Color Function

15 On Green The On LED activates when the
ISD 510 servo drive or SAB it is
connected to receives power from
the mains or auxiliary supply, or a
DC bus terminal.

16 Warn Yellow When warning conditions are met,
the yellow Warn LED activates and
text appears in the display area
identifying the problem.

17 Alarm Red A fault condition causes the red
Alarm LED to flash and an alarm
text is shown.

Table 3.20 Indicator Lights (LEDs)

System Description VLT® Integrated Servo Drive ISD® 510 System
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D. Operation keys and reset
Operation keys are located at the bottom of the LCP.

 Key Function

18 Hand On Enables the connected ISD 510 servo drive
or SAB to be controlled via the LCP.
Switching between Hand On and Auto On
modes is only possible in certain states (see

the VLT®  Integrated Servo Drive ISD®  510
System Programming Guide for further
information).

19 Off Puts the SAB into state  Standby and the
drive to state Switch on Disabled.
This only works in Hand On mode. 
Off mode enables transition from Hand On
mode to Auto On mode.

20 Auto On Puts the system in remote operational mode.

• In Auto On mode, the device is controlled
by fieldbus (PLC).
Note that switching between Auto On
and Hand On modes is only possible
when the drive is in state Switch on
disabled and/or the SAB is in state
Standby.

21 Reset Resets the ISD 510 servo drive or SAB after a
fault has been cleared.
The reset is only possible when in Hand On
mode

Table 3.21 Operation Keys and Reset

NOTICE
To adjust the display contrast, press [Status] and the
[▲]/[▼] keys.

3.5 Cables

3.5.1 Hybrid Cable
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Illustration 3.12 Hybrid Loop Cable

There are 2 types of hybrid cables that are available with
both angled and straight M23 connectors:

• Feed-in cable for connecting the 1st servo drive of
a group to the connection point on the SAB.

• Loop cable for connecting the ISD 510 servo
drives in daisy-chain format in an application.

Both these cables are provided by Danfoss and are
available in various lengths. See the VLT®  Integrated Servo
Drive ISD®  510 System Design Guide for further information.

Both ends of the loop cable are fitted with M23
connectors.

The feed-in cable is fitted with an M23 connector at the
output end for connection to the 1st servo drive. At the
input end it is pigtailed with individual connectors for
connection to the corresponding terminals on the SAB.

Minimum bending radius
The maximum number of bending cycles is 5 million at
7.5 x cable diameter (15.6 mm).

• Permanently flexible: 12 x cable diameter

• Permanently installed: 5 x cable diameter

Description Shielded/
unshielded

Maximum
cable
length

Port Notes

Feed-in
cable

Shielded 40 m1) Signal/
control

Hybrid cable
(overall shield
with additional
fieldbus and
safety section
shield).

Loop cable Shielded 25 m1) Signal/
control

Hybrid cable
(overall shield
with additional
fieldbus and
safety section
shield).

Table 3.22 Hybrid Cables

1) Maximum 100 m total length for each line.

3.5.2 I/O and/or Encoder Cable

This cable connects the I/O and/or encoder to the servo
drive (see X4 in chapter 3.2.3.1 Connectors on the Servo
Drives). The cable is not included with the servo drives.
I/O and/or encoder cables with M12 connectors can be
used for the ISD 510 servo system if they comply with the
form factor defined in IEC 61076-2-101.

3.5.3 Additional Cables

Fieldbus extension cable
If this cable is not used, fit the M23 blind cap to the X2
female connector on the last servo drive in the application.

LCP cables

There are 2 kinds of cable for the LCP module that can be
purchased from Danfoss (see the VLT®  Integrated Servo
Drive ISD®  510 System Design Guide):

• To connect the LCP to the servo drive.

• To connect the LCP to the SAB.
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3.6 Connection Cables/Cabling

3.6.1 Layout and Routing

The servo drives are interconnected by hybrid loop cables.
A hybrid feed-in cable with quick-release connectors
provides the supply voltage from the SAB to the 1st servo
drive.

Routing in drag chains
The hybrid cable is compatible with drag chains and
therefore suitable for use in moving systems. The number
of bending cycles is dependent on individual conditions
and must therefore be determined in advance for each
application, see chapter 3.5.1 Hybrid Cable for further
information.

Maximum cable lengths

M23 Feed-in cable 40 m

M23 Loop cable 25 m

Fieldbus extension cable Length: 2 m
Maximum length to next port:
100 m

Maximum cable length per line 100 m

Table 3.23 Maximum Cable Lengths

Chapter 3.6.1.1 Standard Cabling Concept for 2 Lines and
chapter 3.6.1.2 Standard Cabling Concept for 1 Line show the
standard cabling concept without redundancy that can be
used to connect 1 or 2 lines, each with up to 32 servo
drives in an application.

NOTICE
For cabling with redundancy, see the VLT®  Integrated
Servo Drive ISD®  510 System Design Guide.

3.6.1.1 Standard Cabling Concept for 2
Lines
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Illustration 3.13 Standard Cabling Concept for 2 Lines

3.6.1.2 Standard Cabling Concept for 1 Line

13
0B

E4
36

.1
0

AUX 1

Status

Hand
On

ResetAuto
On

OK

Back

Cancel
Info

Quick
Menu

Main
Menu

Alarm
Log

AUX 2
SAFE 1
SAFE 2

Status

Hand
On

ResetAuto
On

OK

Back

Cancel
Info

Quick
Menu

Main
Menu

Alarm
Log

LCP

SAB

400-480 V AC

Real-Time Ethernet

1

ISD 510

2

.  .  .

1 M23 Feed-in cable

2 M23 Loop cable

Illustration 3.14 Standard Cabling Concept for 1 Line
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3.7 Software

The software for the ISD 510 servo system comprises:
• The firmware of the VLT® Integrated Servo Drive

ISD® 510 that is already installed on the device
and provides the functionality described in
chapter 7 Operation.

• The firmware of the VLT® Servo Access Box that is
already installed on the device.

• A package of PLC libraries for Automation
Studio™ for operating the ISD 510 devices (see
chapter 6.4.1 Programming with Automation
Studio™ for further information).

• A PLC library for TwinCAT® 2 for operating the
ISD 510 devices (see chapter 6.4.2 Programming
with TwinCAT® for further information).

• ISD Toolbox: A Danfoss PC-based software tool for
commissioning and debugging the devices (see
chapter 6.5 ISD Toolbox for further information).

3.8 Fieldbus

The ISD 510 servo system has an open system architecture
realized by fast Ethernet (100BASE-T) based communi-
cation. The system supports both EtherCAT® and Ethernet
POWERLINK® fieldbuses. See the VLT®  Integrated Servo Drive
ISD®  510 System Programming Guide for further information.

In productive environments, communication to the devices
always takes place via a PLC that acts as a master. The
servo drives and the SABs can be controlled by these
communication methods:

• Using the ISD library (available for TwinCAT® and
Automation Studio™).

• Using the NC axis functionality of TwinCAT®.

• Using the CANopen® CiA DS 402 standard by
reading and writing to objects.

The servo drives and the SABs can be operated with the
following cycle times (for both fieldbuses):

• 400 µs and multiples of it (for example, 800 µs,
1200 µs, and so on).

• 500 µs and multiples of it (for example, 500 µs,
1 ms, and so on).

When the cycle time is a multiple of 400 µs and 500 µs,
the time base of 500 µs is used.

The servo drive and the SAB are certified for both
fieldbuses according to the corresponding rules and
regulations. The servo drive conforms to the CANopen®

CiA DS 402 Drive Profile.

3.8.1 EtherCAT®

The servo drive and the SAB support the following
EtherCAT® protocols:

• CANopen over EtherCAT® (CoE)

• File Access over EtherCAT® (FoE)

• Ethernet over EtherCAT® (EoE)

The servo drive and the SAB support distributed clocks. To
compensate for the failure of a communication cable
section in the system, cable redundancy is available for
both fieldbuses. See the VLT®  Integrated Servo Drive
ISD®  510 System Design Guide for further information.

The EtherCAT® port assignment for the servo drive and
SAB are shown in Illustration 3.15 and Illustration 3.16.
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X1 M23 hybrid cable connector to SAB or previous servo drive.

X2 M23 hybrid cable connector to the next servo drive.

X3 M8 Ethernet cable connector to other EtherCAT® slaves, for

example EtherCAT® encoder.
The connector is only available on the advanced servo drive.

Illustration 3.15 EtherCAT® Port Assignment for the Servo
Drive
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X1 RJ45 cable connector to the PLC or previous slave.

X2 RJ45 cable connector to the PLC or next slave.

X3 RJ45 to M23 hybrid adapter cable to the 1st servo drive on
line 1.

X4 RJ45 to M23 hybrid adapter cable to the 1st servo drive on
line 2.

1 Ports always connected internally in the SAB.

Illustration 3.16 EtherCAT® Port Assignment for the SAB in
Line Topology Mode (default)

3.8.2 Ethernet POWERLINK®

The ISD drive and the SAB are certified according to
DS301 V1.1.0. The following features are supported for the
ISD servo drive and the SAB:

• Work as controlled node.

• Can be operated as multiplexed stations.

• Support of cross-communication.

• Ring redundancy is supported for media
redundancy.

Specific ports are not assigned for Ethernet POWERLINK®.
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4 Mechanical Installation

4.1 Transport and Delivery

4.1.1 Items Supplied

The items supplied for the ISD 510 servo system are:
• ISD 510 servo drives

• Servo Access Box (SAB) including connectors

• This manual

• Feed-in (hybrid) cable

• Loop (hybrid) cable

• Blind caps for connectors M8, M12, and M23

The packaging unit depends on the number of servo
drives delivered. Save the packaging for use in the event of
product return.

4.1.2 Transport

• Always use means of transport and lifting gear
with sufficient load capacity to transport the
servo drives and the SAB.

• Avoid vibration during transport.

• Avoid heavy impacts and blows.

4.1.3 Inspection on Receipt

1. After receiving the delivery, immediately check
whether the items supplied match the shipping
documents. Danfoss does not honor claims for
faults registered later.

2. Register a complaint immediately:

• With the carrier if there is visible
transport damage.

• With the responsible Danfoss represen-
tative if there are visible defects or the
delivery is incomplete.

4.2 Safety Measures during Installation

Always observe the safety instructions in chapter 2 Safety
during installation.

Pay particular attention to ensuring that the following
points are always observed:

• Installation may only be performed by qualified
personnel - see chapter 2.5 Qualified Personnel.

• Installation must be performed with due care and
attention.

• All safety regulations and protective measures
must be complied with, and the environmental
conditions must be observed.

• The manual is read and understood.

4.3 Installation Environment

The installation must provide the following environmental
conditions to allow the ISD 510 servo system to be
operated safely and efficiently.

Servo Drive

• The allowable operating ambient temperature
range and vibration levels must not be exceeded
(see chapter 11.1.5 General Specifications and
Environmental Conditions for further information).

• The allowable relative humidity range is 3–93%,
non-condensing.

• Unrestricted ventilation must be available.

• The mounting structure must be suitable for the
application, adequately rigid, and so on.

SAB

• The allowable operating ambient temperature
range and vibration levels must not be exceeded
(see chapter 11.2.4 General Specifications and
Environmental Conditions for further information).

• The allowable relative humidity range is 5–93%,
non-condensing.

• Minimum 100 mm space is required above and
below the SAB (see chapter 4.5.1 Installation and
Space Requirements for further information).

Contact Danfoss if it is not possible to comply with these
environmental conditions.
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4.4 Preparation for Installation

4.4.1 Servo Drive

Make the following preparations to ensure that the
ISD 510 servo system can be installed reliably and
effectively.

1. Provide a suitable mounting arrangement for the
application. This depends on the type, weight,
and torque of the servo drives.

2. Seat the motor flange flush against the mounting
surface before fixing the servo drive.
Misalignment shortens the life of the bearing and
the coupling components and reduces heat
transfer from the servo drive.

3. Provide contact protection according to local
regulations if hot surfaces can be expected
during operation.

4. Ground the servo drive as described in
chapter 5.4 Grounding.

Always fit couplings and other transfer components in
accordance with local regulations.
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4.4.2 Servo Access Box (SAB)

Drill the holes for the mounting screws according to the template.
All dimensions are in mm.
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Illustration 4.1 SAB Mounting Template

Mechanical Installation Operating Instructions

MG75K102 Danfoss A/S © 12/2015 All rights reserved. 31

4 4



4.5 Installation Procedure

4.5.1 Installation and Space Requirements

Servo Access Box
• The SABs can be mounted next to each other but

require a minimum space of 100 mm at the top
and bottom for cooling.

• In addition to its own dimensions, the SAB needs
100 mm space between the SAB decoupling plate
and cable duct for connecting cables.

Servo Drive
• In addition to its own dimensions, the servo drive

needs space for the hybrid cable. Illustration 4.2
shows the necessary space when using the
angled connector. Illustration 4.3 shows the
necessary space when using the straight
connector.

• The amount of space necessary for installation
depends on the tool used.

min 100mm

13
0B

E6
60

.1
0

Illustration 4.2 Required Horizontal Space
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Illustration 4.3 Required Vertical Space

4.5.2 Installation Aids and Tools Required

For installation of the servo drives, the tools corresponding
to the fixing screws (not included) are required.

4.5.3 Fitting Instructions Servo Drive

The servo drives are delivered with an M23 transport
protection cap. The M23 blind cap used for IP protection
must be ordered separately. The advanced servo drive is
delivered additionally with M8 and M12 blind caps. These
blind caps prevent contamination of the servo drive and
are necessary to achieve the relevant IP protection rating.
Always mount these caps if the connector is not used.

NOTICE
Ensure the machine surface that comes in contact with
the servo flange is unpainted in order to guarantee good
thermal behavior of the servo drive. The surface contact
must also provide sufficient grounding protection.

Clamping
Observe the following fitting instructions to ensure reliable
and effective fitting of the servo drive:

1. Check the counterface of the motor mount and
ensure that it has sufficient heat dispersion
capacity. An unpainted surface is mandatory.

2. Remove the protective end cap from the shaft.

3. Fix the servo drive with 4 screws using the 4
mounting holes provided for this purpose in the
machine unit (see Illustration 4.4 and
Illustration 4.5).

• Always use the designated mounting
holes in the mounting flange to fix the
servo drive.

• Do not modify the mounting holes.

• Always use all 4 mounting holes. The
motor may run unevenly if fewer
mounting holes are used.

• See chapter 4.5.4 Tightening Torques for
tightening torques.
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Illustration 4.4 Mounting of Size 1, 1.9 Nm, Size 2, 2.9 Nm,
and Size 2, 3.8 Nm Servo Drives
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Illustration 4.5 Mounting of Size 2, 2.1 Nm Servo Drive

Coupling

NOTICE
Do not machine the shaft.
Do not use the servo drive if the shaft does not match
the coupling arrangement.

General instructions

NOTICE
Do not use excessive force during the fitting procedure:

• Do not exceed the vibration limits as detailed in
chapter 11.1.5 General Specifications and Environ-
mental Conditions.

• Do not exceed the permitted forces as detailed
in chapter 11.1.4 Permitted Forces.

1. Align the clamping set to the axis of the servo
drive.

2. Insert the shaft in the clamping set.

3. Screw the clamping set together.

4.5.4 Tightening Torques

Table 4.1 lists the tightening torque values for the fixing
screws. Always tighten the fixing screws uniformly and
crosswise.

Servo drive size Thread type/
hole size

Maximum
thread length

Tightening
torque

Size 1, 1.5 Nm ∅ 5.8 mm – –

Size 2, 2.1 Nm M6 pitch 1 mm 23 mm 6 Nm

Size 2, 2.9 Nm ∅ 7 mm – –

Size 2, 3.8 Nm ∅ 7 mm – –

Table 4.1 Tightening Torques

NOTICE
The fixing screws are not supplied and must be selected
according to the machine fixings.

4.5.5 Fitting Instructions Servo Access Box
(SAB)

Step 1: Mount the decoupling plate
Mount the decoupling plate as shown in Illustration 4.6.

1. Slide the decoupling plate [3] into position,
ensuring that the lips [2] are correctly inserted
into the corresponding slots on the base plate.

2. Tighten the screw [1] at the top of the
decoupling plate with 2 Nm.

3. Tighten the screws [4] at the bottom of the
decoupling plate with 2 Nm.
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Illustration 4.6 Mounting the Decoupling Plate

Step 2: Mount the SAB in the control cabinet using the
holes drilled as described in chapter 4.4.2 Servo Access
Box (SAB) (preparation for installation).

• Hook the SAB onto the holding screws on the
backplate of the control cabinet.

• Tighten the holding screws.

• Tighten the screws at the bottom of the SAB.

NOTICE
A remote mounting kit is available to mount the LCP in
the control cabinet door. See the VLT®  Integrated Servo
Drive ISD®  510 System Design Guide for further
information.
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5 Electrical Installation

5.1 Warnings

During electrical installation, observe the relevant local and
national regulations in addition to the information in this
manual.

WARNING
LEAKAGE/GROUNDING CURRENT HAZARD
Leakage/grounding currents are >3.5 mA. Failure to
ground the SAB and the ISD servo drives properly could
result in death or serious injury.

• Ensure the correct grounding of the devices by
a certified electrical installer in accordance with
applicable national and local electrical
standards and directives and the instructions
contained in this manual.

WARNING
HIGH VOLTAGE
The SAB contains high voltage when connected to the
supply that could result in death or serious injury.

• Ensure that installation, start-up, and
maintenance are only performed by qualified
personnel.

5.2 Electrical Environmental Conditions

Compliance with the following electrical environmental
conditions is necessary to enable safe and effective
operation of the ISD 510 servo system:

• Grounded 3-phase mains network, 400–480 V AC

• 3-phase frequency 47–63 Hz

• 3-phase lines and PE line

• External controller supply input, 24–48 V DC
(PELV)

• Observe the national statutory provisions.

• The leakage current is >3.5 mA. Therefore use a
type B residual current device (RCD).

• The SAB must be mounted in a control cabinet.

5.3 EMC-Compliant Installation

To obtain an EMC-compliant installation, follow the
instructions provided in chapter 5.4 Grounding and
chapter 5.8 Connecting the Components.

5.4 Grounding

Grounding for electrical safety
• Ground the ISD servo drive with the PE wire of

the feed-in cable (see chapter 5.8 Connecting the
Components).

• Ensure that the machine frame has a proper
electrical connection to the flange of the servo
drive. Use the front side flange surface. Ensure PE
connection on that part of the machine. Refer to
the VLT®  Integrated Servo Drive ISD®  510 System
Design Guide for further information.

• Use a dedicated ground wire for input power and
control wiring.

• Do not ground 1 SAB to another in a daisy-chain
format.

• Keep the ground wire connections as short as
possible.

• Follow the wiring requirements in this manual.

• Ensure a minimum ground wire cross-section of
at least 10 mm2 or 2 separate ground wires both
complying with the dimensioning rules. See EN/
IEC 61800-5-1 for further information.

Grounding for EMC-compliant installation
• Establish electrical contact between the cable

shield and the SAB enclosure by using metal
cable glands, or by using the clamps provided on
the SAB (see chapter 5.8 Connecting the
Components).

• Use high-strand wire to reduce electrical
interference.

• Do not use pigtails.

• Ensure a minimum distance of 200 mm between
signal and power cables.

• Only cross cables at 90°.

NOTICE
POTENTIAL EQUALIZATION
There is a risk of electrical interference when the ground
potential between the ISD 510 servo system and the
machine is different. Install equalizing cables between
the system components. The recommended cable cross-
section is 16 mm2.
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NOTICE
EMC INTERFERENCE
Use shielded cables for control wiring and separate
cables for power and control wiring. Failure to isolate
power and control wiring can result in unintended
behavior or reduced performance. Ensure a minimum
clearance of 200 mm between signal and power cables.

5.5 Mains Supply Requirements

In addition to the electrical environmental conditions
stated in chapter 5.2 Electrical Environmental Conditions,
ensure that the supply has these properties:

• Grounded 3-phase mains network, 400–480 V AC

• 3-phase frequency: 47–63 Hz

• 3-phase lines and PE line

• Mains supply: 400–480 V ±10%

• Continuous input current SAB: 12.5 A

• Intermittent input current SAB: 20 A

NOTICE
Use fuses and/or circuit breakers on the supply side of
the SAB to comply with CE or UL as detailed in Table 5.1.

CE Compliance (IEC 60364) UL Compliance
(NEC 2014)

Recommended
fuse size

Recommended
circuit breaker

Maximum
trip level

in [A]

Recommended
maximum fuse

size

gG-16 Eaton/Moller
PKZM0-16

16 • Littelfuse®

KLSR015

• Littelfuse®

FLSR015

Table 5.1 Fuses and Circuit Breakers

5.6 Auxiliary Supply Requirements

Supply the SAB with a power supply unit with an output
range of 24–48 V DC ±10%. The output ripple of the
power supply unit must be <250 mVpp. Only use supply
units that conform to the PELV specification.
Refer to the VLT®  Integrated Servo Drive ISD®  510 System
Design Guide for power ratings shell diagrams.

NOTICE
Use a supply that is CE-marked according to the
standards EN 61000-6-2 and EN 61000-6-4 or similar for
industrial use.

The power supply unit must be dedicated to the ISD 510
servo system, meaning that the supply is used exclusively
for powering the SAB. The maximum cable length between
the supply unit and the SAB is 3 m.

5.7 Safety Supply Requirements

Supply the STO line with a 24 V DC supply with the
following properties:

• Output range: 24 V DC ±10%

• Maximum current: 1 A

NOTICE
Use a 24 V supply unit that is CE marked according to
the standards EN 61000-6-2 and EN 61000-6-4 or similar
for industrial use. The supply must only be used for the
ISD 510 safety input. The supply must fulfill the PELV
specification.
It is possible to use the auxiliary supply for the STO
function if the following conditions are met:

• Output range: 24 V DC ±10%

• Maximum cable length: 3 m
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5.8 Connecting the Components

5.8.1 Servo Access Box

WARNING
HIGH VOLTAGE
Potentially lethal voltage is present on the connectors.

• Before working on the power connectors
(disconnecting or connecting the cable),
disconnect the SAB from the mains and wait for
the discharge time to elapse.

Step 1: Connect the feed-in cable
1
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6
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1 24/48 V IN (auxiliary input terminal)

2 Cable tie

3 Cable clamp for ISD Line 1: STO 1 (STO output to hybrid
cable line 1)

4 PE grounding

5 Cable clamp for feed-in cable

6 Feed-in cable for line 1

7 Feed-in cable for line 2

Illustration 5.1 Connecting the Feed-In Cable

1. Insert the 4 connectors on the feed-in cable into
their corresponding terminal block on the SAB.

2. Secure the feed-in cable [6] using the cable
clamp [5], ensuring that the shield is positioned
exactly under the clamp.

3. Secure the STO cable using the cable clamp [3],
ensuring that the shield is positioned exactly
under the clamp.

4. Ground the PE wire using the PE terminal [4].

NOTICE
If using 2 lines of servo drives, repeat the process for the
2nd line [7].

Step 2: Connect the AUX cable
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1 Cable tie

2 Cable clamp for ISD Line 2: STO 2 (STO output to hybrid
cable line 2)

Illustration 5.2 AUX Connector on the SAB

1. Insert the wires into the 24/48 V IN (auxiliary
input) connector as described in
chapter 3.3.1.7 AUX Connectors.

2. Insert the 24/48 V IN (auxiliary input) connector
into the SAB and secure the cable using the cable
tie [1].
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Step 3: Connect the mains cable
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1 Mains connector

2 PE screw

3 Cable tie fixing

4 Cable clamp for brake resistor cable (optional)

5 Cable clamp for mains cable

Illustration 5.3 Mains Connector on the SAB

1. Insert the wires into the mains connector as
described in chapter 3.3.1.2 Mains Connectors.

2. Connect the PE wire to the PE screw [2].

3. Insert the mains connector [1].

4. Secure the mains cable using the cable clamp [5].

5. If using a brake resistor, decouple the cable using
the brake cable clamp [4].

6. If using a relay, decouple the cable with a cable
tie to the fixing [3].

Step 4: Connect the encoder, Real-Time Ethernet, and
STO cables

1. Open the terminal cover and the front cover with
a screwdriver as shown in graphics Illustration 5.4
and Illustration 5.5.
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Illustration 5.4 Opening the Terminal Cover
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Illustration 5.5 Opening the Front Cover
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1 Ethernet input X1 & X2

2 Encoder terminal

3 STO 1 IN: 24 V & STO 1 IN: STO

4 STO 2 IN: 24 V & STO 2 IN: STO

5 Cable clamps for STO cables

6 Cable ties for Ethernet cables

7 Cable clamp for encoder cable

Illustration 5.6 Encoder, Real-Time Ethernet, and STO Cables

1. Connect the Ethernet cables [1] and fix them in
position using cable ties [6] as shown in
Illustration 5.6.

2. Connect the STO wires to the STO connectors STO
1 IN: 24 V [3] and STO 2 IN: 24 V [4] as described
in chapter 3.3.1.1 STO Connectors and refer to the
installation instructions in chapter 8.6 Installation.

3. Plug the connectors into the SAB and clamp the
cables in position using the cable clamps [5].

4. If using an encoder:

4a Connect the encoder wires to the
relevant connector as described in
chapter 3.3.1.5 Encoder Connectors.

4b Insert the encoder connector into the
encoder terminal [2] on the SAB and
clamp the cable in position using the
cable clamp [7]. Ensure that the shield is
positioned exactly under the clamp.

5.8.2 Servo Drive

5.8.2.1 Connecting/Disconnecting Hybrid
Cables

WARNING
HIGH VOLTAGE
Potentially lethal voltage is present on the connectors.

• Before working on the power connectors
(disconnecting or connecting the cable),
disconnect the SAB from the mains and wait for
the discharge time to elapse.

WARNING
DISCHARGE TIME
The servo drives and the SAB contain DC-link capacitors
that remain charged for some time after the mains
supply is switched off at the SAB. Failure to wait the
specified time after power has been removed before
performing service or repair work could result in death
or serious injury.

• To avoid electrical shock, fully disconnect the
SAB from the mains and wait for at least the
time listed in Table 5.2 before carrying out any
maintenance or repair work on the ISD 510
servo system or its components.

Number Minimum waiting time (minutes)

0–64 servo drives 10 

Table 5.2 Discharge Time

General instructions for cable installation

• Avoid mechanical tension for all cables, especially
regarding the range of motion of the installed
servo drive.

• Secure all cables in accordance with regulations
and depending on conditions on site. Ensure that
cables cannot come loose, even after prolonged
operation.

• If the X3, X4, and X5 connectors are not used,
always mount the corresponding blind cap.

NOTICE
Never connect or disconnect the hybrid cables to or from
the servo drive when the supply voltage is present.
Doing so damages the electronic circuitry. Observe the
discharge time for the DC-link capacitors.
Do not forcefully connect or fit the connectors. Incorrect
connection causes permanent damage to the connector.
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Connecting cables
1. Align the female connector of the M23 feed-in

cable to the male input connector (X1) of the 1st

servo drive.

2. Fully rotate the threaded ring of the cable
connector counterclockwise. Use the marking
OPEN as a reference for the cable connector.

3. Ensure the marking OPEN on the cable connector
is facing the servo drive.

4. Press the connector towards the electronic
housing on the servo drive until the sealing on
the servo connector is covered entirely by the
cable connectors.

5. Tighten the M23 feed-in cable connector by
rotating the threaded ring clockwise out of the
flat area around the OPEN marking.
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Illustration 5.7 Connecting the M23 Feed-In Cable

6. To add more servo drives in daisy-chain format,
connect the male connector of the loop cable to
the female connector (X2) of the 1st servo drive.

7. Connect the female connector of the loop cable
to the male connector (X1) of the next servo
drive, and so on.

8. Tighten the threaded rings by hand as described
in step 5.

9. Ensure that there is no mechanical tension on the
cables.
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1 X1 Male connector

2 X2 Female connector

3 M23 Metal blind cap

Illustration 5.8 Adding Servo Drives in Daisy-Chain Format

10. Screw the M23 metal blind cap onto the unused
M23 female output connector (X2) on the last
servo drive in the ISD 510 servo system.

11. Tighten the metal blind cap until the sealing on
the servo connector is covered.
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Illustration 5.9 Mounting the M23 Blind Cap
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CAUTION
RISK OF INJURY AND/OR EQUIPMENT DAMAGE
Failure to use the M23 metal blind cap may result in
injury to the operator and/or damage to the servo drive.

• Always fit the M23 metal blind cap as described
in steps 10 and 11.

NOTICE
An angled version of the M23 connector is also available.
The procedure for connecting the angled M23 connector
is the same as for the straight connector.

Disconnecting hybrid cables
1. Disconnect the SAB from its power source (mains

network and UAUX).

2. Wait for the minimum discharge time to elapse.

3. Remove the connector of the feed-in cable from
the SAB.

4. Rotate the threaded ring on the feed-in cable
connector on the servo drive counterclockwise
until the marking OPEN on the cable connector is
facing the servo drive.

5. Pull the connector away from the electronic
housing.

6. Protective blind caps are provided for the X1 and
X2 connectors. Mount the blind caps after
removing the corresponding connector.

5.8.2.2 Connecting/Disconnecting Cables
from Ports X3, X4, and X5

Cable routing
1. Avoid mechanical tension for all cables, especially

regarding the range of motion of the installed
servo drive.

2. Secure all cables in accordance with regulations
and depending on conditions on site. Ensure that
cables cannot come loose, even after prolonged
operation.

Connecting I/O and/or encoder cables
1. Align the connector on the cable with the

connector marked X4 on the servo drive.

2. Press the connector towards the electronic
housing of the servo drive and tighten the
threaded ring of the connector by turning it
clockwise.
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Illustration 5.10 Connecting the I/O and/or Encoder Cable

Illustration 5.10 shows the connection of an I/O or encoder
cable with straight connector to X4 on the servo drive.

NOTICE
The I/O and encoder cable is not supplied.
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Connecting the LCP cable

1. Align the connector on the cable with the LCP
connector marked X5 on the servo drive.

2. Press the connector towards the electronic
housing of the servo drive and tighten the
threaded ring of the connector by turning it
clockwise.
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Illustration 5.11 Connecting the LCP Cable

NOTICE
The LCP cable is not supplied. It can be ordered as an
accessory.

Connecting the 3rd Ethernet device cable
1. Align the connector on the cable with the

Ethernet connector marked X3 on the servo drive.

2. Press the connector towards the electronic
housing of the servo drive and tighten the
threaded ring by turning it clockwise.
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Illustration 5.12 Connecting the 3rd Ethernet Device Cable

Disconnecting cables from ports X3, X4, and X5
1. Loosen the threaded ring of the connector by

turning it counterclockwise.

2. Disconnect the cable from the servo drive.

3. Protective blind caps are provided for the X3, X4,
and X5 connectors. Mount the blind caps after
removing the corresponding connector.
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6 Commissioning

WARNING
UNINTENDED START
The ISD 510 servo system contains servo drives that are
connected to the electrical supply network and can start
running at any time. This may be caused by a fieldbus
command, a reference signal, or by clearing a fault
condition. Servo drives and all connected devices must
be in good operating condition. A deficient operating
condition may lead to death, serious injury, damage to
equipment, or other material damage when the servo
drive is connected to the electrical supply network.

• Take suitable measures to prevent unintended
starts.

6.1 Pre-Commissioning Checklist

Always check the following before initial commissioning
and before commencing operation after extended
downtime or storage:

• Are all threaded connectors of mechanical and
electrical components firmly tightened?

• Is the free circulation of cooling air (inlet and
outlet) assured?

• Are the electrical connections correct?

• Is contact protection in place for rotating parts
and surfaces that can become hot?

6.2 ID Assignment

6.2.1 EtherCAT®

EtherCAT® needs no special ID assignment (IP address).
Special ID assignment is only required, when using indirect
communication via the ISD Toolbox software (see
chapter 6.5.4 ISD Toolbox Communication for further
information).

6.2.2 Ethernet POWERLINK®

Ethernet POWERLINK® master communication cannot be
active when using the ISD Toolbox to assign IDs to the
devices. ID assignment via the ISD Toolbox is only possible
when acyclic Ethernet POWERLINK® communication is
used. If cyclic communication is already started, send an
NMT reset command to all devices manually or perform a
power cycle to stop the cyclic Ethernet POWERLINK®

communication.

6.2.2.1 Single Device ID Assignment

When assigning an ID to a single device, the Device
Information window in the ISD Toolbox can be used (see
the VLT®  Integrated Servo Drive ISD®  510 System
Programming Guide for more information). Setting an ID to
a device can also be done via the LCP.

Setting the node ID directly on a servo drive or on the
SAB
All IP-related parameters are located in parameter group
12-0* IP Settings. According to the Ethernet POWERLINK®

standard, the IP address is fixed to 192.168.100.xxx. The
last number is the value in parameter 12-60 Node ID. For
parameter 12-02 Subnet Mask, the IP address is fixed to
255.255.255.0 and cannot be changed.

Attach the LCP to the servo drive or SAB for which the
Node ID should be changed. Change the value in
parameter 12-60 Node ID to select the desired IP address.

Setting the Node ID for a single servo drive via the SAB
It is also possible to change the Node ID of a servo drive
when the LCP is connected to the SAB. This functionality is
contained in parameter group 54-** ID Assignment on the
SAB in sub-group 54-1* Manual.

1. Attach the LCP to the SAB that is connected to
the servo drive for which the Node ID should be
changed.

2. Configure the parameters:

2a 54-10 EPL ID assignment line

2b 54-11 Drive index (position of the servo
drive in the line)

2c 54-12 EPL ID assignment assign ID

3. Set parameter 54-13 EPL ID assignment start to [1]
start.

6.2.2.2 Multiple Device ID Assignment

When assigning IDs to several devices (for example, when
setting up a new machine), the ISD Toolbox sub-tool SAB
ID assignment can be used (see the VLT®  Integrated Servo
Drive ISD®  510 System Programming Guide for more
information). Setting the IDs of all the servo drives
connected to an SAB at the same time can also be done
via the LCP when it is connected to the SAB.

Setting the Node IDs of all servo drives on an SAB line
The automatic SAB ID assignment is used for automatically
setting the Node IDs on all servo drives for a specified SAB
line. This functionality is contained in parameter group 54-
** ID Assignment on the SAB in sub-group 54-0* Automatic.
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1. Attach the LCP to the SAB that is connected to
the servo drives for which the Node IDs should be
changed.

2. Configure the parameters:

2a 54-02 EPL ID assignment line

2b 54-03 EPL ID assignment start ID

3. Set parameter 54-04 EPL ID assignment start to [1]
start.

6.3 Switching on the ISD 510 Servo System

Complete the cabling of the ISD 510 servo system before
applying power to the servo drives. This cabling provides
the supply voltage and the communication signals for the
ISD 510 servo system. This is a fundamental requirement
for operation of the servo drives.

The ISD 510 servo system can be switched on in 3 ways:
• If the SAB is supplied with mains, STO, and UAUX,

communication to the SAB internal controller is
established and UAUX is automatically passed on
to the connected servo drives.

• If the SAB is only powered by UAUX, then the SAB
and servo drive control units are running.

• If the SAB is only supplied with mains power,
then only the SAB control unit is running and
power is not passed on to the connected servo
drives.

Procedure for switching on the ISD 510 servo system
1. Switch on UAUX power to enable communication

to the SAB and servo drives to be established.

2. Switch on the mains.

3. Set the SAB to state Normal operation (see
chapter 6.5.5 ISD Toolbox Commissioning and
chapter 6.6.2 Simple Programming Template).

Now the SAB and servo drives are ready for operation.

6.4 Basic Programming

The libraries provided for the ISD 510 servo system can be
used in TwinCAT® V2 and in the Automation Studio™
(Version 3.0.90 and 4.x, supported platform SG4)
environment to easily integrate the functionality without
the need of special motion runtime on the controller. The
provided function blocks conform to the PLCopen®

standard. Knowledge of the underlying fieldbus communi-
cation and/or the CANopen® CiA DS 402 profile is not
necessary.

The library contains:
• Function blocks for controlling and monitoring

the servo drive and the SAB.

• Function blocks for all available motion
commands of the servo drive.

• Function blocks and structures for creating Basic
CAM profiles.

• Function blocks and structures for creating
Labeling CAM profiles.

6.4.1 Programming with Automation
Studio™

6.4.1.1 Requirements

The following files are needed to integrate the VLT®

Integrated Servo Drive ISD® 510 and the VLT® Servo Access
Box into an Automation Studio™ project:

• Package of libraries for the ISD 510 servo system:
Danfoss_VLT_ISD_510.zip

• XDD file (XML Device Description) for the servo
drive: 0x0300008D_ISD510.xdd

• XDD file (XML Device Description) for the SAB:
0x0300008D_SAB.xdd

6.4.1.2 Creating an Automation Studio™
Project

The following instructions are for Automation Studio™
3.0.90.

Information on how to install Automation Studio™ can be
found in detail in the Automation Studio™ help. Open the
B&R Help Explorer and go to [Automation software →
Software Installation → Automation Studio].

Information on how to create a new project in Automation
Studio™ can be found in detail in the Automation
Studio™ help. Open the B&R Help Explorer and go to
[Automation Software → Getting Started → Creating
programs with Automation Studio → First project with X20
CPU].

How to include the ISD 510 libraries into an Automation
Studio™ project:

1. In the Logical View, open the menu entry [File →
Import…].

2. In the next window, select the
Danfoss_VLT_ISD_510.zip file (according to the
location on the hard drive).

3. Click on Open.

4. Assign the libraries to the CPU in the next
window.

5. Click on Finish. Now the libraries are integrated
into the Automation Studio™ project.

A new folder containing the ISD libraries is created during
integration:

• ISD_51x
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- Contains program organization units
(POUs) that are defined by PLCopen®

(name starting with MC_) and POUs that
are defined by Danfoss (name starting
with DD_). The Danfoss POUs provide
additional functionality for the servo
drive.

- It is possible to combine POUs defined
by PLCopen® with POUs defined by
Danfoss.

- The names of the POUs that target the
servo drive all end with _ISD51x.

• SAB_51x

- Contains POUs that are defined by
Danfoss (name starting with DD_) and
provide the functionality for the SAB.

- The names of the POUs that target the
SAB all end with _SAB.

• BasCam_51x

- Contains POUs for the creation of basic
CAMs.

• LabCam_51x

- Contains POUs for the creation of
labeling CAMs.

• Intern_51x

- Contains POUs that are needed
internally for the libraries.

- Do not use these POUs in an
application.

When integrating the ISD_51x package, some standard
libraries are integrated automatically, unless they are
already part of the project.

Illustration 6.1 Standard Libraries

NOTICE
Do not remove these libraries otherwise the ISD libraries
will not work.

Inside the library, the following lists of constants are
defined:

• AxisErrorCodes

- Constants for error codes of the axis.

- Error codes can be read using the
function block MC_ReadAxisError_ISD51x
and/or DD_ReadAxisWarning_ISD51x.

• AxisTraceSignals

- Constants for the trace signals of the
axis.

- Intended to be used with the function
block DD_Trace_ISD51x.

• BasCam_51x

- Constants for the creation of basic
CAMs.

• CamParsingErrors

- Constants for parsing problems of a
CAM.

- Error reason is returned by function
block MC_CamTableSelect_ISD51x.

• Danfoss_VLT_ISD510

- Contains the version information of the
library

• FB_ErrorConstants

- Constants for errors inside POUs.

- The reason is given in an output
ErrorInfo.ErrorID that is available in all
POUs.

• Intern_ISD51x

- Constants which are needed internally
for the library.

- They are not intended to be used in an
application.

• LabCam_51x

- Constants for the creation of labeling
CAMs.

• SabErrorCodes

- Constants for error codes of the SAB.

- Error codes can be read using the
function block DD_ReadSabError_SAB
and/or DD_ReadSabWarning_SAB.

• SabTraceSignals
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- Constants for the trace signals of the
SAB.

- Intended to be used with the function
block DD_Trace_SAB.

• SdoAbortCodes

- Constants for errors concerning reading
and writing of parameters.

- The reason is given in an output
AbortCode that is available in several
POUs.

Instantiating AXIS_REF_ISD51x
Inside the library ISD_51x there is a function block called
AXIS_REF_ISD51x. Create 1 instance of this function block
for every servo drive that has to be controlled or
monitored. To create a link to the physical servo drive, link
each instance to 1 physical servo drive. This is done (in the
Logical View) by initializing each instance with its node
number and the slot name (for example, ‘IF3’) it is
connected to.
Each instance of AXIS_REF_ISD51x is the logical represen-
tation of 1 physical servo drive.

Illustration 6.2 Instantiation of AXIS_REF and Setting of Initial
Values

Instantiating SAB_REF
Inside the library SAB_51x there is a function block called
SAB_REF. Create 1 instance of this function block for every
SAB that has to be controlled or monitored. To create a
link to the physical SAB, link each instance to 1 physical
SAB. This is done (in the Logical View) by initializing each
instance with its node number and the slot name (for
example, IF3) it is connected to.
Each instance of SAB_REF is the logical representation of 1
physical SAB.

Import fieldbus device and add to Physical View

The next step is to import the ISD 510 servo drive into
Automation Studio™:

1. Select the menu entry [Tools → Import Fieldbus
Device…].

2. Select the XDD file 0x0300008D_ISD510.xdd from
its location on the hard drive.
This import only has to be done once per project.
The device is then known to Automation
Studio™.

3. The ISD 510 servo drive can now be added to the
Ethernet POWERLINK® interface of the controller
in the Physical View:

3a Right-click on the controller in the
Physical View and select [Open →
POWERLINK].

3b Right-click on the interface and select
Insert….

3c In the Select controller module window,
select the ISD 510 in the group
POWERLINK Devices.

3d Click on Next.

3e In the next window, enter the node
number of the servo drive.

Illustration 6.3 Add an ISD 510 Servo Drive to the Project

NOTICE
The procedure described here applies to Automation
Studio™ Version 3.0.90. Refer to the Automation
Studio™ Help for the corresponding steps with V4.x.

For each physical servo drive, add 1 entry to the Physical
View of Automation Studio™.
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The next step is to import the Servo Access Box into
Automation Studio™:

1. Select the menu entry [Tools → Import Fieldbus
Device…].

2. Select the XDD file  0x0300008D_SAB.xdd from its
location on the hard drive. This import only has
to be done once per project. The device is then
known to Automation Studio™.

3. The SAB can now be added to the Ethernet
POWERLINK® interface of the controller in the
Physical View:

3a Right-click on the controller in the
Physical View and select [Open →
POWERLINK].

3b Right-click on the interface and select
Insert….

3c In the Select controller module window,
select the SAB in the group POWERLINK
Devices.

3d Click on Next.

3e In the next window, enter the node
number of the SAB.

For each physical SAB, add 1 entry to the Physical View of
Automation Studio™.

Illustration 6.4 1 SAB and 2 ISD 510 Servo Drives Added to the

Ethernet POWERLINK® Interface

I/O configuration and I/O mapping

The I/O Configuration of the servo drive has to be parame-
terized in a way that the library has access to all necessary
objects:

1. Right-click on the entry of the ISD 510 and select
Open I/O Configuration.

2. In the Channels section, change the Cyclic
transmission of the following objects:

2a All subindexes of object 0x5050 (Lib pdo
rx_I5050 ARRAY[]) to Write.

2b All subindexes of object 0x5051 (Lib pdo
tx_I5051 ARRAY[]) to Read.

The I/O Configuration of the SAB has to be parameterized
in a way that the library has access to all necessary
objects:

1. Right-click on the entry of the SAB and select
Open I/O Configuration.

2. In the Channels section, change the Cyclic
transmission of the following objects:

2a All subindexes of object 0x5050 (Lib pdo
rx_I5050 ARRAY[]) to Write.

2b All subindexes of object 0x5051 (Lib pdo
tx_I5051 ARRAY[]) to Read.

These settings configure the cyclic communication with
the device. These parameters are needed to make the
library work.

NOTICE
It is possible to use copy & paste to apply the same I/O
Configuration to multiple devices of the same type.

NOTICE
Set Module supervised to off for the servo drives and the
SAB. The parameter is found in the I/O Configuration of
the device.

Illustration 6.5 I/O Configuration of an ISD 510 Device
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Illustration 6.6 I/O Mapping after Successful Configuration

Map the inputs and outputs of the instance of the
AXIS_REF_ISD51x function block and the physical data
points of the servo drive according to Illustration 6.7 (here
myAxis is an instance of AXIS_REF_ISD51x):

Illustration 6.7  I/O Mapping of an ISD 510 Servo Drive

Map the inputs and outputs of the instance of the SAB_REF
function block and the physical data points of the SAB
accordingly.

Cycle time settings
The minimum cycle time is 400 µs. The ISD 510 devices
can run Ethernet POWERLINK® cycle times in multiples of
400 µs and multiples of 500 µs. The devices are automat-
ically parameterized by the PLC on start-up, depending on
the Ethernet POWERLINK® configuration of the physical
interface. The Ethernet POWERLINK® configuration can be
accessed by right-clicking [CPU → Open IF3 POWERLINK
Configuration] in the Physical View.

NOTICE
The task cycle time of the PLC program should be the
same as the Ethernet POWERLINK® cycle time. Otherwise,
data could be lost and performance may be reduced.

Illustration 6.8 Ethernet POWERLINK® Configuration Window

to Parameterize Ethernet POWERLINK® Cycle Time

Set the PLC cycle time in Automation Studio™:
1. Right-click [CPU → Open Software Configuration]

in the Physical View.

2. Ensure that the PLC cycle time is the same as the
Ethernet POWERLINK® cycle time.

6.4.1.3 Connecting to the PLC

Information on how to connect to the PLC can be found in
detail in the Automation Studio™ Help. Open the B&R Help
Explorer and go to [Automation Software → Getting Started
→ Creating programs with Automation Studio → First
project with X20 CPU → Configure online connection].

6.4.2 Programming with TwinCAT®

6.4.2.1 ISD Deliverables

To integrate the servo drive and the SAB into a TwinCAT®

project, the following files are needed:
• Library for the ISD 510 servo system:

Danfoss_VLT_ISD_510.lib

• ESI file (EtherCAT® Slave Information) for the
servo drive and the SAB: Danfoss ISD 500.xml

6.4.2.2 Creating a TwinCAT® Project

Information on how to install TwinCAT® can be found in
detail in the Beckhoff Information System
(infosys.beckhoff.com). Open the information system and
select [TwinCAT 2 → TwinCAT Quick Start → Installation].

Information on how to create a new project in TwinCAT®

can be found in detail in the Beckhoff Information System
(http://infosys.beckhoff.com). Open the information system
and select [TwinCAT 2 → TwinCAT Quick Start or TwinCAT 2
→ TX1200 TwinCAT PLC → TwinCAT PLC Control].
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How to include the ISD 510 library into a TwinCAT®

project:
1. In the Resources tab of TwinCAT® PLC Control,

open the Library Manager.

2. In the upper left area of the Library Manager
window, right-click and select Additional Library
….

3. Select the Danfoss_VLT_ISD_510.lib file (according
to the location on the hard drive).

4. Click on Open. Now the libraries are integrated
into the TwinCAT® PLC control project.

Inside the library, the POUs are organized into folders:
• BasCam_51x

- Contains POUs for the creation of basic
CAMs.

• ISD_51x

- Contains POUs defined by PLCopen®

(Name starting with MC_) and POUs
defined by Danfoss (name starting with
DD_). The POUs defined by Danfoss
provide additional functionality for the
axis.

- It is possible to combine POUs defined
by PLCopen® with POUs defined by
Danfoss.

- The names of the POUs that target the
servo drive all end with _ISD51x.

• Intern_51x

- Contains POUs that are needed
internally for the libraries.

- Do not use these POUs in an
application.

• LabCam_51x

- Contains POUs for the creation of
labeling CAMs.

• SAB_51x

- Contains POUs that are defined by
Danfoss (Name starting with DD_) and
provide the functionality for the SAB.

- The names of the POUs that target the
SAB all end with _SAB.

When integrating the ISD 510 library, some standard
libraries are integrated automatically, unless they are
already part of the project.

NOTICE
Do not remove these libraries otherwise the ISD libraries
will not work.

Illustration 6.9 Library Manager after Including the ISD 51x
Library

Inside the library, the following lists of constants are
defined:

• AxisErrorCodes

- Constants for error codes of the axis.

- Error codes can be read using the
function block MC_ReadAxisError_ISD51x
and/or DD_ReadAxisWarning_ISD51x.

• AxisTraceSignals

- Constants for the trace signals of the
axis.

- Intended to be used with the function
block DD_Trace_ISD51x.

• BasCam_51x

- Constants for the creation of basic
CAMs.

• CamParsingErrors

- Constants for parsing problems of a
CAM.

- Error reason is returned by function
block MC_CamTableSelect_ISD51x.

• Danfoss_VLT_ISD510

- Contains the version information of the
library.

• FB_ErrorConstants

- Constants for errors inside POUs.

- The reason is given in an output
ErrorInfo.ErrorID that is available in all
POUs.

• Intern_51x

- Constants that are needed internally for
the library.

- They are not intended to be used in an
application.

• LabCam_51x
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- Constants for the creation of labeling
CAMs.

• SabErrorCodes

- Constants for error codes of the SAB.

- Error codes can be read using the
function block DD_ReadSabError_SAB
and/or DD_ReadSabWarning_SAB.

• SabTraceSignals

- Constants for the trace signals of the
SAB.

- Intended to be used with the function
block DD_Trace_SAB.

• SdoAbortCodes

- Constants for errors concerning reading
and writing of parameters.

- The reason is given in an output
AbortCode that is available in several
POUs.

Instantiating AXIS_REF_ISD51x
Inside the folder  ISD_51x in library Danfoss_VLT_ISD_510
there is a function block called AXIS_REF_ISD51x. Create 1
instance of this function block for every servo drive that
has to be controlled or monitored. Each instance of
AXIS_REF_ISD51x is the logical representation of 1 physical
servo drive.

Instantiating SAB_REF
Inside the folder SAB_51x in library Danfoss_VLT_ISD_510
there is a function block called SAB_REF. Create 1 instance
of this function block for every SAB that has to be
controlled or monitored.

Each instance of SAB_REF is the logical representation of 1
physical SAB.

NOTICE
When compiling the library, check that the option
Replace constants under [Project → Options... → Build] is
activated.

Afterwards, save and compile the project to update the
automatically generated variable information for the
TwinCAT®  System Manager.

Illustration 6.10 Instantiation of AXIS_REF_ISD51x

Append a PLC Project into TwinCAT® System Manager
To create a link between the TwinCAT®  PLC Control project
and the TwinCAT®  System Manager, connect the saved
project, especially the inputs and outputs, to the TwinCAT®

System Manager:
1. To add the project information to the TwinCAT®

System Manager, right-click on PLC-Configuration
and select Append PLC project….

2. In the  Insert IEC1131 Project window, select the
project information file according to the location
on the hard drive. The file has the same name as
the PLC project, but with the file extension .tpy.

3. Click on Open.

Import fieldbus device and add to TwinCAT®

The next step is to import the servo drive and the SAB into
the TwinCAT®  System Manager software:

1. Copy the ESI file Danfoss ISD 500.xml into the
folder TwinCAT Installation Folder\Io\EtherCAT on
the hard drive. This only has to be done once per
project. The TwinCAT®  System Manager automat-
ically searches for ESI files at this location on the
hard drive during startup.

2. To add an EtherCAT® master, right-click on [I/O-
Configuration → I/O Devices] and select Append
Device….

3. In the following window, select [EtherCAT →
EtherCAT] (see Illustration 6.11).

4. Click on OK.

5. Select Device 1 (EtherCAT®) and select the correct
Network Adapter on the right side of the window
in the Adapter tab.
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6. To add an SAB, right-click on Device1 (EtherCAT®)
and select Append Box….

7. In the Insert EtherCAT Device window, select
[Danfoss GmbH → VLT® ISD Series → VLT® Servo
Access Box L1] for Line 1 of the SAB (and/or VLT®

Servo Access Box L2 for Line 2 of the SAB).

8. Click on OK.

9. To add a servo drive to line 1 of the SAB, right-
click on Box 1 (VLT®  Servo Access Box L1) and
select Append Box...

10. In the Insert EtherCAT Device window, select
[Danfoss GmbH → VLT® ISD Series → VLT® ISD 510
Integrated Servo Drive].

11. Click on OK.

12. Answer the question if the drive is used as an NC
axis with No. If the drive should be used as an NC
axis, see chapter 6.4.2.3 Configuration as a
TwinCAT®  NC Axis.

NOTICE
Add 1 entry to the EtherCAT® master of the TwinCAT®

System Manager for each physical servo drive and SAB.
Add the servo drive to the correct SAB line.

Illustration 6.11 Add an EtherCAT® Master to the Project

Illustration 6.12 Add an ISD 510 Servo Drive to the Project
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Illustration 6.13 TwinCAT® System Manager after Appending
the PLC Project and Adding an SAB and 2 Servo Drives

I/O configuration and I/O mapping
When connecting >1 servo drive, connect port C (X2) of
the previous drive to port A (X1) of the next servo drive.
The SAB port assignment must also be followed, see
chapter 3.8.1 EtherCAT®. If the hardware set-up is already
present, the TwinCAT® System Manager Scan devices
function can be used to automatically add the connected
devices to the configuration in the correct order.

The servo drive has to be configured so that the PDO
mapping matches the requirements of the library. This is
done inside the TwinCAT®  System Manager.

1. Click on the ISD servo drive entry.

2. Select the Slots tab on the right side of the
window.

3. Remove the current PDO configuration by
selecting the entry Module 1 (CSV PDO) in the Slot
box.

4. Click on X.

5. Select Library PDO in the Module box.

6. Click on <.

Illustration 6.14 ISD 510 Servo Drive with Correct I/O Configu-
ration

Attach the input and output variables of the PLC program
to the physical inputs and outputs of the device. This is
done inside the TwinCAT®  System Manager so that the
library has access to all necessary objects.

1. Select Library TxPDO via menu [I/O-Configuration
→ I/O Devices → Device1 (EtherCAT®) → Box 1
(VLT® Servo Access Box L1) → Drive 2 (VLT® ISD
510 Integrated Servo Drive) → Module 1 (Library
PDO) → Library TxPDO].

2. Select all entries  Lib pdo tx1 to Lib pdo tx9 on the
right side of the window (see Illustration 6.15).

3. Right-click and select Change Multi Link….

4. In the  Attach Variable 36.0 Byte(s) (Input) window,
select [PLC-Configuration → MyFirstIsd510Project
→ Standard → .myAxis.TPDO].
Ensure that the Matching Size option is selected
in the Attach Variable window.

5. Click OK.

6. Click on Library RxPDO via menu [I/O-Configu-
ration → I/O Devices → Device1 (EtherCAT®) →
Box1 (VLT® Servo Access Box L1) → Drive2 (VLT®

ISD 510 Integrated Servo Drive) → Module1
(Library PDO) → Library RxPDO].

7. Select all entries Lib pdo rx1 to Lib pdo rx9 on the
right side of the window.
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8. Right-click and select Change Multi Link….

9. In the Attach Variable 36.0 Byte(s) (Output) window
select [PLC-Configuration → MyFirstIsd510Project
→ Standard → .myAxis.RPDO].

10. Click on OK.

11. Right-click on WcState via [I/O-Configuration →
I/O Devices → Device1 (EtherCAT®) → Box1 (VLT®

Servo Access Box L1) → Drive2 (VLT® ISD 510
Integrated Servo Drive) → WcState] and select
Change Link….

12. In the Attach Variable State (Input) window select
[PLC-Configuration → MyFirstIsd510Project →
Standard → .myAxis.WcState.

13. Click on OK.

14. Right-click on State via [I/O-Configuration → I/O
Devices → Device1 (EtherCAT®) → Box1 (VLT®

Servo Access Box L1) → Drive2 (VLT® ISD 510
Integrated Servo Drive) → InfoData] and select
Change Link….

15. In the Attach Variable State (Input) window select
[PLC-Configuration → MyFirstIsd510Project →
Standard → .myAxis.State.

16. Click on OK.

17. Right-click on netId via [I/O-Configuration → I/O
Devices → Device1 (EtherCAT®) → Box1 (VLT®

Servo Access Box L1) → Drive2 (VLT® ISD 510
Integrated Servo Drive) → InfoData → AdsAddr]
and select Change Link….

18. In the Attach Variable netId (Input) window select
[PLC-Configuration → MyFirstIsd510Project →
Standard → .myAxis.AmsNetId.].

19. Click on OK.

20. Right-click on port via [I/O-Configuration → I/O
Devices → Device1 (EtherCAT®) → Box1 (VLT®

Servo Access Box L1) → Drive2 (VLT® ISD 510
Integrated Servo Drive) → InfoData → AdsAddr]
and select Change Link….

21. In the Attach Variable port (Input) window select
[PLC-Configuration → MyFirstIsd510Project →
Standard → .myAxis.NodeNumber.].

22. Click on OK.

Illustration 6.15 Attaching Inputs and Outputs to the Physical
Data Points

NOTICE
Repeat the steps 2–22 for Box 1 (VLT® Servo Access Box
L1) and the instance mySAB.

To transfer the mappings back to the PLC program, select
Activate Configuration… in menu item Actions.
After a rebuild in TwinCAT®  PLC Control, the TwinCAT®

configuration is according to Illustration 6.16 (here myAxis
and mySecondAxis are instances of AXIS_REF_ISD51x and
mySAB is an instance of SAB_REF). The concrete addresses
can be different.

Illustration 6.16 TwinCAT® Configuration: I/O Mapping of 2
Servo Drives and an SAB
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NOTICE
It is recommended to put the SAB to a separate SYNC
unit so that the communication to the SAB is not
interrupted if the UAUX supply to the servo drives is
switched off due to an error.

Cycle time settings

The minimum cycle time is 400 µs. The ISD 510 devices
can run EtherCAT® cycle times in multiples of 400 µs or
500 µs. The devices are automatically parameterized by the
PLC on start-up, depending on the EtherCAT® configuration
of the physical interface. The system base time can be
accessed by selecting [SYSTEM-Configuration → Real-Time
Settings] in the TwinCAT®  System Manager. Multiples of this
base time can then be used as EtherCAT® cycle times.

NOTICE
Set the task cycle time of the PLC program to be the
same as the EtherCAT® cycle time. Otherwise data can
get lost and performance is reduced.

Set the PLC cycle time in TwinCAT®  PLC Control:
1. Double-click Task configuration in the Resources

tab.

2. Ensure that the PLC cycle time is the same as the
EtherCAT® cycle time.

Illustration 6.17 Task Configuration to Parameterize PLC Cycle
Time

NOTICE
After changing the task cycle time in TwinCAT®  PLC
Control, carry out a ReScan of the PLC configuration
inside the TwinCAT®  System Manager to update the
settings. Afterwards, activate the configuration in the
PLC.

6.4.2.3 Configuration as a TwinCAT® NC
Axis

It is possible to use the servo drives with the built-in NC
functionality of TwinCAT®. Everything that is related to the
SAB needs to be done as described in
chapter 6.4.2.2 Creating a TwinCAT®  Project.

1. In addition to the Danfoss_VLT_ISD_510.lib file,
include the TcMC2.lib file (the
Danfoss_VLT_ISD_510.lib file is still needed for the
SAB to be operated).

2. Create 1 instance of AXIS_REF (instead of
AXIS_REF_ISD51x) for each servo drive that is used
as an NC axis.

3. Append the PLC project into the TwinCAT®

System Manager, import the devices and add
them to TwinCAT® as described in
chapter 6.4.2.2 Creating a TwinCAT®  Project,
however in the last step, answer the question if
the servo drive is used as an NC axis with Yes.
Then an NC task is created automatically.

In the TwinCAT® System Manager a different I/O Configu-
ration needs to be selected for the drives that are used as
NC axes.

1. Depending on the mode of operation to be used,
select either the slot CSP PDO or CSV PDO. Per
default, CSV PDO is mapped and pre-selected. If
the drive should work with CSP PDO, the variables
need to be mapped:

1a In the Settings Tab of the NC Axis select
[NC-Configuration → NC-Task 1 SAF →
Axes → Axis 1]. Click on the Link To (all
Types)… button and select the desired
servo drive.

2. In the same tab, select the preferred Unit.

3. Depending on the selected Unit, adjust the
Scaling Factor for the axis encoder via menu [NC-
Configuration → NC-Task 1 SAF → Axes → Axis 1 →
Axis 1_Enc] in the Parameter tab.
Example: When the unit Degrees is selected, the
scaling factor is 360°/220 = 0.00034332275390625.

4. Set the Reference Velocity in the Parameter tab via
menu [NC-Configuration → NC-Task 1 SAF → Axes
→ Axis 1 → Axis 1_Enc.

5. Set the Output Scaling Factor (Velocity) to 125.

6. Test the functionality and the configuration in the
Online tab of the axis.
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6.4.2.4 Connecting to the PLC

Information on how to connect to the PLC can be found in
detail in the Beckhoff Information System (http://
infosys.beckhoff.com). Open the information system and go
to [TwinCAT 2 → TwinCAT System Manager → Operation →
Controls → Choose Target System].

6.4.3 Programming Guidelines

Recommendations for implementation:
• Initialize parameters that usually do not change

only once at the beginning of the program. In
Automation Studio™, use the _INIT section.

• Call up function blocks that provide status or
error information with Enable input at the
beginning of the program.

• It is recommended to have 1 instance of the
function block MC_Power_ISD51x for every axis in
order to control its power stage. Call up this
function block in every PLC cycle.

• It is recommended to have 1 instance of the
function block DD_Power_SAB for every SAB to
control the DC-link voltage on the output lines.
Call up this function block in every PLC cycle.

• Call up function blocks that execute (motion)
commands at the end of the program.

• Do not use any POUs of the library (folder)
Intern_51x.

• Do not change the reference to the axis on a
function block while it is busy.

Illustration 6.18 shows sample code for TwinCAT®.
Illustration 6.18 Sample Code for TwinCAT®

NOTICE
The full parameter list can be found in the VLT®

Integrated Servo Drive ISD®  510 System Programming
Guide.
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6.5 ISD Toolbox

6.5.1 Overview

The ISD Toolbox is a standalone PC software designed by
Danfoss. It is used for parameterization and diagnostics of
the servo drives and the SAB. It is also possible to operate
the devices in a non-productive environment. The ISD
Toolbox contains several functionalities, called sub-tools,
which in turn provide various functionalities.

The most important sub-tools are:
• Scope for visualization of the tracing functionality

of the servo drives and SAB.

• Parameter list for reading/writing parameters.

• Firmware update

• Drive control/SAB control to operate the servo
drives and/or SAB for testing purposes.

• CAM editor for designing CAM profiles for the
servo drives.

The detailed description of the ISD Toolbox functionality
and the full list of parameters can be found in the VLT®

Integrated Servo Drive ISD®  510 System Programming Guide.

6.5.2 System Requirements

To install the ISD Toolbox software, the PC must meet the
following requirements:

• Supported hardware platforms: 32-bit, 64-bit.

• Supported operating systems: Windows XP
Service Pack 3, Windows 7, Windows 8.1.

• .NET framework version: 3.5 Service Pack 1.

• Minimum hardware requirements: 512 MB RAM,
Intel Pentium 4 with 2.6 GHz or equivalent, 20 MB
hard disk space.

• Recommended hardware requirements: Minimum
1 GB RAM, Intel Core i5/i7 or compatible.

6.5.3 Installation

Administrator rights are required for installing the software
with the Windows operating system. Contact your adminis-
trator if necessary.

1. Check that your system meets the system
requirements as described in chapter 6.5.2 System
Requirements.

2. Download the ISD Toolbox installation file (http://
vlt-drives.danfoss.com/products/engineering-
software/software-download/).

3. Right-click on the .exe file and select Run as
administrator.

4. Follow the on-screen instructions to complete the
installation process.

6.5.4 ISD Toolbox Communication

This chapter describes the Ethernet specific network
interface settings needed by the ISD Toolbox. There are 2
basic communication methods: direct communication and
indirect communication. Their particular network settings
are described in the respective sections.

Read and perform the steps with care - incorrect network
configurations can lead to loss of connectivity of a network
interface.

Firewall
Depending on the firewall settings and the fieldbus used,
the messages sent and received by the ISD Toolbox may
be blocked by the firewall on the ISD Toolbox host system.
This may lead to a loss of communication and the inability
to communicate with the devices on the fieldbus.
Therefore, ensure that the ISD Toolbox is allowed to
communicate through the firewall on the ISD Toolbox host
system. Read and perform the steps with care - inappro-
priate changes to firewall settings may lead to security
issues.

NOTICE
When using a dedicated network interface, the ISD
Toolbox should be allowed to communicate specifically
through this network interface.

Indirect communication
Communication between ISD 510 devices and the ISD
Toolbox through a PLC is called indirect communication.
Between the PLC and the ISD 510 devices there is
Ethernet-based fieldbus communication (marked A in
Illustration 6.19), whereas there is non-fieldbus communi-
cation between the PLC and the ISD Toolbox host system
(marked B in Illustration 6.19).

In the scenario in Illustration 6.19, the PLC has the master
function and uses cyclic communication with the devices.
Therefore, not all functionalities of the ISD Toolbox, for
example the drive control, can be used. The restrictions
when using indirect communication are detailed in the
VLT®  Integrated Servo Drives ISD®  510 Programming Guide.
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Illustration 6.19 Logical View of Indirect Ethernet-based
Fieldbus Communication (Communication via PLC)

NOTICE
The logical view only shows the connectivity from a
high-level software perspective and does not reflect the
actual physical topology of the network.

Direct communication
For Ethernet-based fieldbus communication (direct
communication), the ISD Toolbox must use a dedicated
network interface on the ISD Toolbox host system. This
network interface should not simultaneously be used for
any other communication.
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Illustration 6.20 Logical View of Direct Ethernet-based Fieldbus
Communication

NOTICE
The logical view only shows the connectivity from a
high-level software perspective and does not reflect the
actual physical topology of the network.

6.5.4.1 Network Settings for Indirect
Communication

Any network interface can be used to communicate
through a PLC and a dedicated network interface is not
needed.

When establishing the communication through a PLC, the
ISD Toolbox configures a routing table using the selected
Network Address Translation (NAT). Adding a route to the
Windows routing table requires administrator privileges.
Therefore, administrator credentials may be requested
when initializing the connection.

Carry out the following steps to enable indirect communi-
cation.

Disable IPv6 on the network interfaces used for communi-
cation on the PC:

1. Open the Network and Sharing Center.

2. Select Change adapter settings.

3. Right-click on the network interface used for
fieldbus communication and select Properties.

4. If the TCP/IPv6 is available for the network
interface, disable it.

Illustration 6.21 Local Area Connection Properties
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NOTICE
When observing the network packets via Wireshark®,
checksum offloading often causes confusion as the
network packets to be transmitted are handed over to
Wireshark® before the checksums have been calculated.
Wireshark® shows these empty checksums as invalid,
even though the packets contain valid checksums when
they leave the network hardware later.

Use 1 of these 2 methods to avoid this checksum
offloading problem:

• Turn off the checksum offloading in the network
driver if possible.

• Turn off the checksum validation of the specific
protocol in the Wireshark® preferences.

Additional settings for indirect communication over
EtherCAT®

Set the IP address of the EtherCAT® Master:
1. Open the TwinCAT®  System Manager.

2. Select [I/O-Configuration → I/O Devices → Device1
(EtherCAT®)] and check the IP-address in the
Adapter tab.
The IP-address of the PLCs network adapter may
not be a link-local address (so not in the range of
169.254.0.1 to 169.254.255.254).

3. If necessary, change the IP-address inside the IPv4
Protocol properties according to the given
operating system. This can be done on the
controller locally or via Remote Desktop.

Activate IP routing on the EtherCAT® Master:

NOTICE
The procedure described here may vary depending on
the type of PLC and operating system installed.

1. Open the TwinCAT®  System Manager.

2. Click on Advanced Settings… under [I/O-Configu-
ration → I/O Devices → Device1 (EtherCAT®)] in
the EtherCAT tab.

3. Select EoE Support in the Advanced Settings
window.

4. Enable Connect to TCP/IP Stack in the Windows
Network section.

5. Enable IP Enable Router in the Windows IP Routing
section.

6. Reboot the PLC for the changes to take effect.

Set the IP address of the EtherCAT® slave (servo drive or
SAB):

1. Open the TwinCAT®  System Manager.

2. Click on Advanced Settings… under [I/O-Configu-
ration → I/O Devices → Device1 (EtherCAT®) → Box
1 (VLT® Servo Access Box L1 → Drive 2 (VLT®

Integrated Servo Drive ISD 510)] in the EtherCAT
tab.

3. Select [Mailbox → EoE] in the Advanced Settings
window.

4. Enable Virtual Ethernet Port and enter a valid IP
Address.

5. Each slave in the configuration requires an IP-
address. This address is reassigned with every
transition from INIT to Pre-Operational state of the
slave state machine. The IP communication of the
slaves is deactivated per default.

NOTICE
The last number of the IP address is the ID that is used
in the ISD Toolbox to identify the device.

6.5.4.2 Network Settings for Direct
Communication with Ethernet
POWERLINK®

Disable all network protocols except TCP/IPv4 on the
network interface used for direct Ethernet POWERLINK®

communication. This prevents other PC software or the
operating system using this network interface for other
tasks, such as file and printer sharing and network
discovery. Disabling these protocols reduces the number of
non-relevant packets sent over the network interface and
thus reduces the overall network load.

How to disable all unused protocols on the network
interface on the PC:

1. Open the Network and Sharing Center.

2. On the left, click on Change adapter settings.

3. Right-click on the network interface used for
fieldbus communication and select Properties.

4. Uncheck all checkboxes except the one for
Internet Protocol Version 4 (TCP/IPv4).
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Illustration 6.22 Local Area Connection 2 Properties

Disable the IPv4 Checksum offload on the network
interfaces as described in chapter 6.5.4.1 Network Settings
for Indirect Communication.

How to set the correct Ethernet POWERLINK® master IP
address:

1. Open the Network and Sharing Center.

2. On the left, click on Change adapter settings.

3. Right-click on the network interface used for
fieldbus communication and select Properties.

4. Click on Internet Protocol Version 4 (TCP/IPv4) (the
checkbox must be checked) and then click on
Properties.

5. Select Use the following IP address and use
192.168.100.240 as the IP address and
255.255.255.0 as the subnet mask. Leave all other
fields empty.

Illustration 6.23 Internet Protocol Version 4 (TCP/IPv4)
Properties

6.5.4.3 Network Settings for Direct
Communication with EtherCAT®

No EtherCAT®-specific network interface configuration
needs to be performed on the ISD Toolbox host PC.
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6.5.5 ISD Toolbox Commissioning

STEP 1: Open the main window
The Main Window is the basis for all ISD Toolbox functionalities. It consists of the following components:

13
0B

E3
11

.1
0

1
2

3

4

5

7

8

9

6

Illustration 6.24 Main Window
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1 Menu bar Contains the general functionalities for saving and loading projects, managing connections,
showing and changing settings, managing open sub-tools, and showing help contents.

2 Tool bar Contains shortcuts for saving and loading projects, connecting to and disconnecting from
networks, automatic searching for online devices, or manually adding devices.

3 Online/Offline status and state
information

• Online devices are indicated by a glowing light bulb next to the device ID.

- An online device is a logical device for which a physical device exists, which the
ISD Toolbox is currently connected to.

- The color indicates the state of the device and is device–specific.

• Offline devices are indicated by a gray light bulb next to the device ID.

- An offline device is a logical device without a corresponding physical device. An
offline device can represent a saved device configuration or state, for example for
offline analysis or troubleshooting. It also contains pre-configured parameter
values to be written to a physical device.

4 Available sub-tools A sub-tool is opened by double-clicking the left mouse button on its name in the Device
Environment,  or by selecting the entry and pressing the Enter key on the keyboard.

5 Device environment The Device Environment section of the Main Window lists all logical devices managed by the
ISD Toolbox, visualizes their states, and serves as the user interface for accessing the device
functionalities.
The Device Environment window lists all available sub-tools for each added device. See the

VLT®  Integrated Servo Drive ISD®  510 System Programming Guide for further information on the
sub-tools.

6 Workspace This is the space for hosting the sub-tools and its size depends on the Main Window size. The
sub-tools can be maximized, minimized, horizontally or vertically aligned, or cascaded.

7 Watchlist window Evaluates the parameter values of 1 or more devices by cyclically reading them from the
devices. Allows parameter values to be logged and saved to a text file. It is also possible to
modify/write values in the watchlist.

8 Output window Shows operating information, warnings, and errors. Depending on the user settings, shows
messages of up to 3 different logging levels (high, medium, and low). Used for showing
advanced error and warning information.

9 Status strip Shows the communication state of the ISD Toolbox. If connected to a network, it shows the
used hardware interface (for example, network adapter) and the network name.

Table 6.1 Legend to Illustration 6.24

STEP 2: Connect to network

NOTICE
Pre-configure the appropriate communication settings to
connect to a network. See chapter 6.5.4 ISD Toolbox
Communication for further information.

1. In the Main Window toolbar, click on the Connect
to bus icon to open the Connect to Network
window.

2. Select the fieldbus type and the network
interface to connect to.

3. Click on OK to connect.

4. Verify that the connection is successful by
checking the status strip in the Main Window. Illustration 6.25 Connect To Network Window (Ethernet

POWERLINK®)
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STEP 3: Scan for devices

1. After verifying that the ISD Toolbox is connected
to the selected network, click on the Scan for
Devices icon in the toolbar to trigger the device
scan procedure.

NOTICE
If connected to an Ethernet POWERLINK® network in
cyclic mode, select the scan range (minimum and
maximum IDs) in the next window to reduce the time
needed for scanning. In all other cases, the complete ID
range is scanned.

2. When the scan is complete, a list of available
devices is showed in the Select Devices window.
Select which devices to add to the Device
Environment and click on OK.

3. All selected devices appear in the Device
Environment window and automatically go online
(indicated by a glowing light bulb next to each
device name).

NOTICE
See the VLT®  Integrated Servo Drive ISD®  510 System
Programming Guide for further information on the ISD
Toolbox software.

6.6 Motion Library

6.6.1 Function Blocks

The PLC library provides function blocks that support the
functionality of the ISD devices and comply with this
standard:

PLCopen® Technical Specification Function blocks for
motion control (Formerly Part 1 and Part 2) Version 2.0
March 17, 2011.

Additionally, specific ISD function blocks provide the
functionality that is not described by PLCopen®.

The following PLCopen® characteristics apply to all
function blocks:

• Commanding (using the inputs)

• Signaling (behaviour of the outputs)

• General calling conventions

NOTICE
See the VLT®  Integrated Servo Drive ISD®  510 System
Programming Guide for further information on the
available function blocks and their behavior.

6.6.2 Simple Programming Template

Automation Studio™
Detailed information on how to open the sample project
within the ISD package in Automation Studio™ can be
found in the Automation Studio™ Help. Open the B&R
Help Explorer and go to [Programming → Examples →
Adding sample programs] and follow the instructions for
library samples.

TwinCAT®

A basic sample PLC application for starting up the ISD 510
servo system with 1 SAB and 2 axes is provided. The
project ISD_System_SampleProject can be downloaded from
the Danfoss website.
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7 Operation

7.1 Operating Modes

The servo drive implements several modes of operation. The behavior of the servo drive depends on the activated mode of
operation. It is possible to switch between the modes while the servo drive is enabled. The supported modes of operation
are according to CANopen® CiA DS 402 and there are also ISD-specific modes of operation. All supported modes of
operation are available for EtherCAT® and Ethernet POWERLINK®. The various modes of operation are described in detail in
the VLT®  Integrated Servo Drive ISD®  510 System Programming Guide.

Mode Description

ISD Inertia measurement
mode

This mode measures the inertia of an axis. It is used to measure the inertia of the servo drive and the
external load, and to optimize the control loop settings. The friction effects are eliminated automatically.

Profile velocity mode In profile velocity mode, the servo drive is operated under velocity control and executes a movement with
constant speed. Additional parameters, such as acceleration and deceleration, can be parameterized.

Profile position mode In profile position mode, the servo drive is operated under position control and executes absolute and
relative movements. Additional parameters, such as velocity, acceleration, and deceleration, can be parame-
terized.

Profile torque mode In profile torque mode, the servo drive is operated under torque control and executes a movement with
constant torque. Linear ramps are used. Additional parameters, such as torque ramp and maximum
velocity, can be parameterized.

Homing mode In homing mode, the application reference position of the servo drive can be set. Several homing methods,
such as homing on actual position, homing on block, limit switch, or home switch are available.

CAM mode In CAM mode, the servo drive executes a synchronized movement based on a master axis. The synchroni-
zation is done by means of a CAM profile that contains slave positions corresponding to master positions.
CAMs can be designed graphically with the ISD Toolbox software, or can be parameterized via the PLC. The
guide value can be provided by an external encoder, virtual axis, or the position of another axis. The

different CAM profile types are described in the VLT®  Integrated Servo Drive ISD®  510 System Programming
Guide.

Gear mode In gear mode, the servo drive executes a synchronized movement based on a master axis by using a gear
ratio between the master and the slave position. The guide value can be provided by an external encoder,
virtual axis, or the position of another axis.

Cyclic synchronous position
mode

In cyclic synchronous position mode, the trajectory generator of the position is located in the control
device, not in the servo drive.

Cyclic synchronous velocity
mode

In cyclic synchronous velocity mode, the trajectory generator of the velocity is located in the control
device, not in the servo drive.

Table 7.1 Operating Modes

7.1.1 Motion Functions

Function Description

Digital CAM
switch

This functionality controls whether the digital
output is enabled or disabled, depending on the
axis position. It performs a function comparable
to switches on a motor shaft. Forward and
backward movements of the axis position are
allowed. On and off compensation and hysteresis
can be parameterized.

ISD touch
probe

This functionality stores the position actual value
after a rising or falling edge at the configured
digital input.

Table 7.2 Motion Functions

7.2 Operating Status Indicators

The operating status of the servo drive and SAB is
indicated via the LEDs on each device.
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7.2.1 Operating LEDs on the Servo Drive

Illustration 7.1 shows the operating LEDs on the servo
drive.

DRIVE STAT X1

X2

X3

NET STAT

LINK/ACT

DRIVE STAT X1

X2NET STAT

LINK/ACT

Advanced Standard

13
0B

E6
77

.1
0

Illustration 7.1 Operating LEDs on the Servo Drive

LED Color Flash status Description

DRIVE
STAT

Green On Servo drive is in state
Operation enabled.

Flashing Auxiliary voltage is
applied.

Red On Servo drive is in Fault
or Fault reaction active
state.

Flashing DC-link voltage is not
applied.

NET
STAT

Green/
red

Fieldbus dependent Network status of the
device (see
corresponding fieldbus
standard).

Link/A
CT X1

Green – Link/activity status of
Hybrid In (X1)

On Ethernet link
established.

Flashing Ethernet link
established and active.

Off No link.

Link/A
CT X2

Green – Link/activity status of
Hybrid Out (X2)

On Ethernet link
established.

Flashing Ethernet link
established and active.

Off No link.

LED Color Flash status Description

Link/A
CT

X31)

Green – Link/activity status of
the Ethernet port (X3).

On Ethernet link
established.

Flashing Ethernet link
established and active.

Off No link.

Table 7.3 Legend to Illustration 7.1

1) Advanced version only

7.2.2 Operating LEDs on the Servo Access
Box

Aux 1
Aux 2
Safe 1
Safe 2
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Illustration 7.2 Operating LEDs on the SAB

LED Color Flash status Description

Aux 1 Green – State of the auxiliary
voltage on line 1.

On Statemachine is in
state Standby,  Power
up,  or Operation
enabled.  Auxiliary
voltage is applied to
the output connectors
on line 1.

Off Statemachine is in
state UAUX  disabled or
Fault. Auxiliary voltage
is not applied to line 1.
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LED Color Flash status Description

Aux 2 Green – State of the auxiliary
voltage on line 2.

On Statemachine is in
state Standby,  Power
up,  or Operation
enabled.  Auxiliary
voltage is applied to
the output connectors
on line 2.

Off Statemachine is in
state UAUX  disabled or
Fault. Auxiliary voltage
is not applied to line 2.

Safe 1 Green On 24 V for STO is present
on line 1.

Off 24 V for STO is not
present on line 1.

Safe 2 Green On 24 V for STO is present
on line 2.

Off 24 V for STO is not
present on line 2.

SAB
STAT

Green On SAB is in state
Operation enabled.

Flashing Auxiliary voltage is
applied at the input.

Off No auxiliary voltage is
applied at the input.

Red On The SAB is in state
Fault.

Flashing Mains is not applied at
the input.

NET
STAT

Green/
red

Fieldbus dependent. Network status of the
device (see
corresponding fieldbus
standard).

Link/A
CT X1

Green – Link/activity status of
In.

On Ethernet link
established.

Flashing Ethernet link
established and active.

Off No link.

Link/A
CT X2

Green – Link/activity status of
Out.

On Ethernet link
established.

Flashing Ethernet link
established and active.

Off No link.

LED Color Flash status Description

Link/A
CT X3

Green – Link/activity status of
line 1.

On Ethernet link
established.

Flashing Ethernet link
established and active.

Off No link.

Link/A
CT X4

Green – Link/activity status of
line 2.

On Ethernet link
established.

Flashing Ethernet link
established and active.

Off No link.

Table 7.4 Legend to Illustration 7.2
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8 ISD Safety Concept

8.1 Applied Standards and Compliance

Use of the STO function requires that all provisions for
safety, including relevant laws, regulations, and guidelines,
are satisfied.

The integrated STO function complies with the following
standards:

• EN 60204-1: 2006 Stop Category 0 – uncontrolled
stop

• IEC/EN 61508: 2010 SIL 2

• IEC/EN 61800-5-2: 2007 SIL 2

• IEC/EN 62061: 2005 SIL CL2

• EN ISO 13849-1: 2008 Category 3 PL d

The ISD 510 servo system has been tested for higher EMC
immunity as described in IEC/EN 61326-3-1.

8.2 Abbreviations and Conventions

Abbreviation Reference Description

Cat. EN ISO
13849-1

Category, level B, 1–4

DC – Diagnostic coverage

FIT – Failure in time
Failure rate: 1E-9/hour

H EN IEC 61508 Hardware fault tolerance
H = n means that n + 1 faults may
lead to a loss of the safety
function.

MTTFd EN ISO
13849-1

Mean time to failure – dangerous
Unit: years

PFH EN IEC 61508 Probability of dangerous failures
per hour
Take this value into account if the
safety device is operated in high
demand mode or in continuous
operating mode, where the
frequency of demands for
operation made on a safety-related
system occurs more than once per
year.

PFD EN IEC 61508 Average probability of failure on
demand.
This value is used for low demand
operation.

PL EN ISO
13849-1

Performance level
A discrete level used to specify the
capability of safety-related parts of
a system to perform safety-
oriented functions under
foreseeable conditions. Levels: a–e.

Abbreviation Reference Description

SFF EN IEC 61508 Safe Failure Fraction [%]
Proportion of safe failures and
detected dangerous failures of a
safety function or a subsystem as a
percentage of all possible failures.

SIL EN IEC 61508
EN IEC 62061

Safety Integrity Level

STO EN IEC
61800-5-2

Safe Torque Off

SS1 EN IEC
61800-5-2

Safe stop 1

SRECS EN IEC 62061 Safety-related electrical control
system

SRP/CS EN ISO
13849-1

Safety-related parts of control
systems

PDS/SR EN IEC
61800-5-2

Power drive system (safety-related)

Table 8.1 Abbreviations and Conventions

8.3 Qualified Personnel for Working with
the STO Function

The STO function may only be installed, programmed,
commissioned, maintained, and decommissioned by
qualified personnel. Qualified personnel for the STO
function are qualified electrical engineers, or persons who
have received training from qualified electrical engineers
and are suitably experienced to operate devices, systems,
plant, and machinery in accordance with the general
standards and guidelines for safety technology.

Furthermore they must:
• Be familiar with the basic regulations concerning

health and safety/accident prevention.

• Have read and understood the safety guidelines
given in this manual.

• Have a good knowledge of the generic and
specialist standards applicable to the specific
application.

Users of power drive systems (safety-related) (PDS(SR)) are
responsible for:

• Hazard and risk analysis of the application.

• Identifying safety functions required and
allocating SIL or PLr to each of the functions,
other subsystems, and the validity of signals and
commands from them.

• Designing appropriate safety-related control
systems (hardware, software, parameterization,
and so on).
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Protective measures

• Install the ISD 510 servo system components with
a protective rating of less than IP54 in an IP54
cabinet as per IEC 60529 or in an equivalent
environment. In special applications, higher IP
protection may be necessary.

• If external influences can influence the motor
axis, for example suspended loads, use additional
measures, such as a safety holding brake, to
eliminate hazards.

8.4 Safety Precautions

NOTICE
After installing the STO function, perform a commis-
sioning test as described in chapter 8.9 Commissioning
Test. A passed commissioning test is mandatory after
initial installation and after each change to the safety
installation.

WARNING
UNCONTROLLED MOVEMENT
External forces on the motor could cause an uncontrolled
and hazardous movement that could result in death or
serious injury.

• Equip the motor with additional measures for
preventing uncontrolled and hazardous
movement, for example mechanical brakes.

WARNING
RISK OF ELECTRICAL SHOCK
The STO function itself does not supply electrical safety
and is not sufficient to implement the Emergency-Off
function as defined by EN 60204-1, resulting in risk of
death or serious injury.

• Ensure electrical isolation for Emergency-Off, for
example by switching off the mains via an
additional contactor.

WARNING
RISK OF ELECTRICAL SHOCK
The STO function does not isolate mains voltage to the
ISD 510 servo system or auxiliary circuits. Only perform
work on electrical parts of the ISD510 system or the
servo drive after isolating the mains voltage supply and
waiting the length of time specified in chapter 2 Safety.
Failure to isolate the mains voltage supply and waiting
the time specified could result in death or serious injury.

• Do not use the STO function to stop a running
ISD 510 servo system in normal operation.
When using the STO function the servo drive
coasts to stop. Depending on the application, a
mechanical brake may be required.

• Use the STO function when performing
mechanical work on the ISD 510 servo system
or affected area of a machine. The STO function
does not provide electrical safety and must not
be used as a control to start and/or stop the
ISD 510 servo system.

NOTICE
The ISD 510 servo system does not implement a manual
reset function as required by ISO 13849-1. The standard
failure reset from the PLC cannot be used for this
purpose.
For automatic restart without manual reset, observe the
requirements detailed in paragraph 6.3.3.2.5 of ISO
12100:2010 or equivalent standard.

WARNING
RISK OF RESIDUAL ROTATION
Due to failures in the power semiconductor of the drive,
a residual rotation can result from a fault that could
result in death or serious injury. The rotation can be
calculated to angle = 360°/(number of poles).

• Take this residual rotation into consideration
and ensure that it does not pose a safety risk.

NOTICE
Take measures to ensure that common mode voltage
disturbances, as described in EN/IEC 61000-4-16, do not
occur in the installation. This can be done, for example,
by installing according to the requirements of EN/
IEC 60204-1.

NOTICE
Carry out a risk assessment to select the correct stop
category for each stop function in accordance with
EN 60204-1.
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NOTICE
When designing the machine application, consider
timing and distance for coast to stop (Stop Category 2 or
STO). See EN 60204-1 for further information.

NOTICE
All signals connected to the STO must be supplied by a
SELV or PELV supply.

8.5 Functional Description

The STO function in the ISD 510 servo system features a
separate STO function for each line of servo drives in daisy-
chain format. The function is activated by inputs on the
SAB. Using the STO function activates the STO for all servo
drives on that line. Once the STO is activated, no torque is
generated on the axes. Reset of the safety function and
diagnostics can be carried out via the PLC.

8.6 Installation

Install the ISD 510 servo system as described in
chapter 4 Mechanical Installation and chapter 5 Electrical
Installation. Only Danfoss cables may be used for the
installation of the servo system, however cables from other
suppliers may be used for the user connection to the STO
terminals (STO 1 IN and STO 2 IN) on the SAB.

NOTICE
If the application does not require the Safe Torque Off
(STO) functionality, build a bridge by connecting +24 V
from the connector STO 1 IN: +24V to STO 1 IN: +STO,
and from STO 1 IN: –24 V to STO 1 IN: –STO. Repeat this
process for STO line 2 if used.

Safety relays that have a plus and minus switching output
signal can be directly connected to the ISD 510 servo
system to activate STO (see Illustration 8.1). Route the wires
for STO 1 and STO 2 separately and not in a single
multicore cable.
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SAB

STO 1 IN: + STO 

STO 1 IN: – STO 

STO 2 IN: + STO 

STO 2 IN: – STO 

Illustration 8.1 Safety Relay with Plus and Minus Switching
Output

Signals with test pulses must not have test pulses of >1
ms. Longer pulses may lead to reduced availability of the
servo system.

The external supply must be a SELV/PELV supply.

8.7 Operation of the ISD Safety Concept

This chapter details the basic STO signals. Some of the
signals can be reached in several ways, however only
access via fieldbus is described here. See the VLT®

Integrated Servo Drive ISD®  510 System Programming Guide
for further information.

The STO function does not require any parameterization
and is always enabled. To disable the function
permanently, connect the STO inputs directly to the 24 V
outputs STO 1 IN: 24 V or STO 2 IN: 24 V on the SAB.

The ISD 510 servo drive provides STO status signals via the
fieldbus.

For general information on how to access and map data
objects, see the VLT®  Integrated Servo Drive ISD®  510 System
Programming Guide.

Danfoss provides a library for ISD 510 to simplify the use
of the fieldbus functions. See the VLT®  Integrated Servo
Drive ISD®  510 System Programming Guide for further
information.

8.7.1 Statusword

The statusword in 0x6041 provides the STO status in bit 14.
The bit is set to 1 if STO is active and 0 if STO is
deactivated. All servo drives on each STO line must display
the same information in this bit. Carry out a check via the
PLC to compare the STO status of all servo drives on each
line.

If STO is activated when the servo drive is disabled, and no
attempt is made to enable the servo drive while STO is
active, it is not necessary to reset the STO function after
reapplying supply to the STO terminals.

If STO is activated when the servo drive is enabled, an
error code is issued (see chapter 8.7.2 Error Codes).
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8.7.2 Error Codes

If bit 3 of the statusword is set, this indicates any faults
that occur on the servo drive. If the fault occurred because
of the STO circuit, the cause of the fault can be found in
object 0x603F.

Error
code

Classifi-
cation

Description Reset

0xFF80 Fault STO activated while the servo
drive was enabled, or an
attempt to enable the servo
drive was made while STO
was active.

Reset via the
PLC.

0xFF81 Safety
fault

Servo drive internal diagnostic
fault.

Carry out a
power cycle.

0xFF85 Safety
fault

Internal STO supply on the
power card is not within
limits.

Carry out a
power cycle.

Table 8.2 Error Codes

Error code 0xFF80 can be a normal status of the
application. In this case, the servo drive requires a reset
signal from the PLC. To use the STO function in an
application that requires a control guard (see ISO 12100 for
details), this reset information can be given automatically
by the PLC.

Error code 0xFF81 means that there is a fault on the servo
drive that can only be reset by carrying out a power cycle.
Complete the commissioning test as described in
chapter 8.9 Commissioning Test after the power cycle.
Operation of the ISD 510 servo system can only be
resumed if the test is completed successfully. If error code
0xFF81 or 0xFF85 is issued again, contact Danfoss Service.

8.8 Fault Reset

Change bit 7 of the controlword from 0 to 1 to reset faults.
See the VLT®  Integrated Servo Drive ISD®  510 System
Programming Guide for further information.

8.9 Commissioning Test

NOTICE
Perform a commissioning test after installation of the STO function, after every change to the installed function, or after
a safety fault (described in chapter 8.7.2 Error Codes). Perform the test for each STO line.

There are 2 ways to implement the commissioning test depending on the method used to program the PLC, however the
steps of the test are the same:

• Using the Danfoss Library or the TwinCAT® Library.

• Bit-wise readout of the status.

Commissioning test using libraries
Depending on the application, 1 or both of the following libraries are required to program the commissioning test:

• Danfoss Library

- MC_ReadAxisInfo_ISD51x

- MC_ReadStatus_ISD51x

- MC_ReadAxisError_ISD51x

- MC_Reset_ISD51x

• TwinCAT® Library

- MC_ReadStatus

- MC_ReadAxisError

- MC_Reset

 Test steps Reason for the test step Expected result for Danfoss
library

Expected result for TwinCAT®

library

1 Run the application (all the
servo drives are enabled).

Check that the application can
run.

Application runs as expected. Application runs as expected.

2 Stop the application. – All servo drives are at speed 0
RPM.

All servo drives are at speed 0
RPM.

3 Disable all the servo drives. – All servo drives are disabled. All servo drives are disabled.
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 Test steps Reason for the test step Expected result for Danfoss
library

Expected result for TwinCAT®

library

4 Enable STO. Check that STO can be
activated without error.

MC_ReadAxisInfo_ISD51x output
SafeTorqueOff = True for all
servo drives on the
corresponding line.

–

5 Disable STO. Check that STO can be
deactivated without error. No
reset is required.

MC_ReadAxisInfo_ISD51x output
SafeTorqueOff = False for all
servo drives on the
corresponding line.

–

6 Run the application (all the
servo drives are enabled).

– Application runs as expected. Application runs as expected.

7 Enable STO. Check that errors are
generated correctly when STO
is activated while the servo
drives are running.

Motors are torque free. Motors
coast and stop after some
time.
MC_ReadAxisInfo_ISD51x output
SafeTorqueOff = True
and
MC_ReadStatus_ISD51x output
ErrorStop = True
and
MC_ReadAxisError_ISD51x
output AxisErrorID = 0xFF80 on
all enabled servo drives.

Motors are torque free. Motors
coast and stop after some
time.
For enabled motors:
MC_ReadStatus output ErrorStop
= True
and
MC_ReadAxisError output
AxisErrorID = 0xFF80 on all
enabled servo drives.

8 Try to run the application
(enable 1 or more servo
drives).

Checks that the STO function
is working correctly.

Application does not run. Application does not run.

9 Disable STO. Check that the STO start is
still inhibited by the error
signal.

MC_ReadAxisInfo_ISD51x output
SafeTorqueOff = False
and
MC_ReadStatus_ISD51x output
ErrorStop = True

MC_ReadStatus output ErrorStop
= True

10 Try to run the application
(enable 1 or more servo
drives).

Check whether reset is
required.

Application does not run. Application does not run.

11 Send a reset signal via
MC_Reset(_ISD51x).

– MC_ReadAxisInfo_ISD51x output
SafeTorqueOff = False
and
MC_ReadStatus_ISD51x output
ErrorStop = False

MC_ReadStatus output ErrorStop
= False

12 Try to run the application (all
servo drives are enabled).

– Application runs as expected. Application runs as expected.

Table 8.3 Commissioning Test using Libraries

Commissioning test using bit-wise readout
 Test steps Reason for the test step Expected result

1 Run the application (all the servo drives
are enabled).

Check that the application can run. Application runs as expected.

2 Stop the application. – All servo drives are at speed 0 RPM.

3 Disable all the servo drives. – All servo drives are disabled.

4 Enable STO. Check that STO can be activated without
error.

Statusword bit 3 = 0 and bit 14 =1 in all
servo drives.

5 Disable STO. Check that STO can be deactivated
without error. No reset is required.

Statusword bit 3 = 0 and bit 14 =0 in all
servo drives.
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 Test steps Reason for the test step Expected result

6 Run the application (all the servo drives
are enabled).

– Application runs as expected.

7 Enable STO. Check that errors are generated correctly
when STO is activated while the servo
drives are running.

Motors are torque free. Motors coast and
stop after some time.
Statusword bit 3 = 1, bit 14 = 1 and
object 0x603F shows fault 0xFF80 in all
servo drives.

8 Try to run the application (enable 1 or
more servo drives).

Checks that the STO function is working
correctly.

Application does not run.

9 Disable STO. Check that the STO start is still inhibited
by the error signal.

Statusword bit 3 = 1, bit 14 = 0 and
object 0x603F shows fault 0xFF80 in all
servo drives.

10 Try to run the application (enable 1 or
more servo drives).

Check whether reset is required. Application does not run.

11 Send a reset signal via the PLC. – Statusword bit 3 = 0 in all servo drives.

12 Try to run the application (all servo drives
are enabled).

– Application runs as expected.

Table 8.4 Commissioning Test using Bit-Wise Readout
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8.10 Application Example

Illustration 8.2 shows an example of an installation for 2 lines that can be put in Safe Torque Off mode by separate safety
circuits for each line.

The safety circuits may be remote from each other and are not supplied from the ISD 510 servo system.

The 2 lines in the example are controlled separately. If the Safe Torque Off function is triggered on line 1, line 2 remains in
normal operation and the servo drives on this line are not affected. There may still be a hazard from the servo drives on
line 2.

Select the safety switch devices in accordance with the requirements of the application.

+24 V DC

–24 V DC

13
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1a

1b

2a

2b

3

4

5

6

7

8

9

11

12

14

X1

X2

X1

X2

X1

X2

X1

X2

13

13

11

10

1a/1b ISD 510 servo drive on line 1 7 Safety device on line 2

2a/2b ISD 510 servo drive on line 2 8 Line 2 emergency stop button

3 Servo Access Box (SAB) 9 Line 2 safety device contacts

4 Safety device on line 1 10 Line 1 hybrid cable

5 Line 1 emergency stop button 11 Line 2 hybrid cable

6 Line 1 safety device contacts 12 24 V DC supply

Illustration 8.2 Application Example: Safe Torque Off Function with 2 Lines
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8.11 Safety Function Characteristic Data

General information

Response time (from switching on the
input until torque generation is
disabled)

<100 ms

Lifetime 20 years

Data for EN/ISO 13849-1

Performance level (PL) d

Category 3

Mean time to dangerous failure (MTTFd)
for maximum system size of 32 servo
drives on each STO line

233 years (limited to
100 years if the ISD
510 servo system
forms an entire safety
channel)

Diagnostic coverage (DC) 60%

Data for EN/IEC 61508 and EN/IEC 62061

Safety integrity level (SIL) 2

Probability of failure per hour (PFH) for
maximum system size of 32 servo drives
on each STO line

<5 x 10-8/h

Safe Failure Fraction (SFF) >95%

Hardware fault tolerance (H) 0

Subsystem classification Type A

Proof test interval 1 year

Table 8.5 Safety Function Characteristic Data

8.12 Maintenance, Security, and User
Accessibility

Maintenance
Operate the STO function at least once per year.

Security
If security risks exist, take suitable measures to prevent
them.

User accessibility
Restrict access to the servo drives, SAB, and other ISD 510
servo system components if access to them could result in
safety risks.
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9 Diagnostics

9.1 Faults

If faults occur during servo system operation, check:
• The LEDs on the servo drive for general problems

relating to communication or device status.

• The LEDs on the SAB for general problems with
communication, auxiliary supply, or STO voltage.

The error codes can be read using the ISD Toolbox
software, the LCP, or the PLC. The LCP only shows faults
relating to the device it is connected to.

NOTICE
If the fault cannot be eliminated by 1 of the measures
listed in Table 9.1 or Table 9.3, notify Danfoss Service.

Have the following information available to enable Danfoss
to provide help quickly and effectively:

• Type number

• Error code

• Firmware version

• System set-up (for example, number of servo
drives and lines).

9.2 Servo Drive

9.2.1 Troubleshooting

First use Table 9.1 to check the possible causes of the fault
and possible solutions. The error codes are listed in
chapter 9.2.2 Error Codes.

Fault Possible cause Possible solution

LCP display dark
or has no
function.

Missing input power. Check the input
power source.

Missing or open fuses
or circuit breaker
tripped.

Check the fuses and
circuit breaker.

No power to the LCP. • Check the LCP
cable for proper
connection or
damage.

• Replace any faulty
LCP or connection
cables.

Incorrect contrast
setting.

Press [Status] +

[▲]/[▼] to adjust the

contrast.

Display is defective. Replace the faulty
LCP or connection
cable.

Fault Possible cause Possible solution

Servo drive
overheats (high
surface
temperature).

Excessive load. Check the torques.

Servo drive not
running.

No drive communi-
cation or drive in
error mode.

Check the fieldbus
connection and the
status LEDs on the
servo drive.

Servo drive does
not run or only
starts up slowly or
with difficulty.

• Bearing wear.

• Incorrect
parameter
settings.

• Incorrect control
loop parameters.

• Incorrect torque
settings.

• Check the
bearings and
shaft.

• Check the
parameter
settings.

Drive hums and
draws high
current.

Drive defective. Contact Danfoss.

Drive stops
suddenly and
does not restart.

• No drive
communication.

• Servo drive in
error mode.

Check the fieldbus
connection and the
status LEDs on the
servo drive.

Wrong motor
rotation direction.

Parameter error. • Check the
parameter
settings.

• Change the
rotation direction
if appropriate.

Drive runs
normally, but
does not generate
the expected
torque.

• Drive defective.

• Parameter error.

• Check the
parameter
settings.

• Contact Danfoss.

Drive screaming. • Incorrect
calibration.

• Faulty current
measurement.

• Incorrect control
loop parameters.

• Check the
parameter
settings.

• Contact Danfoss.

Uneven running. Defective bearing. Check the shaft.

Vibration. • Defective bearing.

• Incorrect control
loop parameters.

• Check the shaft.

• Check the
parameter
settings.
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Fault Possible cause Possible solution

(Unusual) running
noises

• Defective bearing.

• Defects on
connected
mechanics.

• Incorrect control
loop parameters.

• Check the shaft.

• Check for loose
mechanical
components on
the attached
mechanics.

• Check the
parameter
settings.

System fuse
blows, circuit
breaker trips, or
drive protection
trips immediately.

• Short circuit.

• Incorrect control
loop parameters.

• Check the wiring.

• Contact Danfoss.

Drive speed drops
sharply under
load.

• Drive is running at
current limit.

• Drive is running
with incorrect
parameters.

• Check the
application.

• Check the
parameter
settings.

Brake does not
release.

Brake control
defective.

Contact Danfoss.

Holding brake
does not hold the
servo drive.

• Mechanical brake
defective.

• Shaft load exceeds
the holding torque
of the brake.

Contact Danfoss.

Brake
engagement
delayed.

Software error. Contact Danfoss.

Noises when
power-off brake
engaged.

Mechanical brake
damaged.

Contact Danfoss.

LEDs do not light
up.

No power supply. Check the power
supply.

Error 0xFF91
occurs.

Increments between
succeeding values too
big.

Check for velocity or
guide value plausi-
bility distance.

Table 9.1 Troubleshooting Servo Drive

9.2.2 Error Codes

Code Name Severity
(Warning/
Error/Trip
lock)

Description LCP name

0x0000 No error Error No error. –

0x1000 Generic
application
error

Error Generic
application
error.

generic err

0x2310 Overcurrent
on output

Error Overcurrent
on output.

overcurr out

Code Name Severity
(Warning/
Error/Trip
lock)

Description LCP name

0x239B Overload on
output (I2T)

Warning,
error

I2t thermal
state.

overload

0x3210 DC link
overvoltage

Error Overvoltage
on DC-link
voltage

UDC
overvolt

0x3220 DC link
undervoltag
e

Error Undervoltag
e on DC-link
voltage.

UDC
undervolt

0x4290 Overtem-
perature:
Power
module

Error Overtem-
perature on
power
module.

overtemp
PM

0x4291 Overtem-
perature:
Control card

Error Overtem-
perature on
control PCB.

overtemp CC

0x4295 Overtem-
perature:
Power card

Error Overtem-
perature on
power PCB.

overtemp PC

0x4310 Overtem-
perature:
Motor

Error Overtem-
perature on
motor.

overtemp
motor

0x5112 UAUX
undervoltag
e

Error, trip
lock

Undervoltag
e on
auxiliary
voltage.

undervolt
UAUX

0x5530 EE
Checksum
Error
(parameter
missing)

Trip lock Missing
parameter in
internal
drive config-
uration.

config err

0x6320 Parameter
error

Trip lock An internal
parameter
has an
invalid value.

param err

0x7320 Internal
position
sensor error

Trip lock Absolute
position
sensor error.

int sensor
err

0x7380 External
position
sensor error

Error External
encoder
data could
not be read.

ext sensor
err

0x8693 Homing
error on
entering
homing
mode

Warning Could not
enter
homing
mode (for
example
velocity not
0).

Homing
mode fail
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Code Name Severity
(Warning/
Error/Trip
lock)

Description LCP name

0x8694 Homing
error on
start homing
method

Warning Could not
start homing
method (for
example
drive not in
standstill).

Homing
method fail

0x8695 Homing
error
distance

Warning Homing
distance
reached.

Homing
distance

0xFF01 Mechanical
brake failure

Trip lock No brake or
wire failure.

brake mech
fail

0xFF02 Short circuit
in
mechanical
brake
control

Trip lock Short circuit
in brake
control.

brake mech
short

0xFF0A External
interface
power
failure

Error External
interface
power
supply
failure.

ext IF pwr
fail

0xFF60 Timing
violation 1

Trip lock Contact
Danfoss.

timing err 1

0xFF61 Timing
violation 2

Trip lock Contact
Danfoss.

timing err 2

0xFF62 Timing
violation 3

Trip lock Contact
Danfoss.

timing err 3

0xFF63 Timing
violation 4

Trip lock Contact
Danfoss.

timing err 4

0xFF64 Timing
violation 5

Trip lock Contact
Danfoss.

timing err 5

0xFF65 Timing
violation 6

Trip lock Contact
Danfoss.

timing err 6

0xFF70 Firmware:
Package
description
mismatch

Trip lock Firmware
found does
not match
the package
description.

FW pack err

0xFF71 Firmware:
Power cycle
needed

Warning,
error

Firmware
update
transfer is
completed
but a power
cycle is
required
before the
new
firmware is
active.

need
powercycle

Code Name Severity
(Warning/
Error/Trip
lock)

Description LCP name

0xFF72 Firmware:
Update
started

Warning,
error

Firmware
update in
progress.
The warning
becomes an
error when
an attempt
is made to
enable the
drive in this
state.

FW update

0xFF80 STO active
while drive
enabled

Error STO
activated
while servo
drive was
enabled or
tried to
enable while
STO active.

STO active

0xFF81 STO
mismatch

Trip lock Dual
diagnosis of
STO voltage
not
plausible.

STO
mismatch

0xFF85 P_STO error Trip lock P_STO
voltage on
power card
not within
limits.

P_STO error

0xFF90 Guide value
reversed

Error Position
guide value
went
backwards
while servo
drive in CAM
mode.

guide val rev

0xFF91 Guide value
implausible

Error Increments
between
succeeding
values too
big.

guide val
impl

Table 9.2 Error Codes for Servo Drive
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9.3 Servo Access Box (SAB)

9.3.1 Troubleshooting

Table 9.3 lists potential faults on the SAB, their possible
causes, and actions for correcting the faults.

Fault Possible cause Possible solution

LCP display
dark or has no
function.

Missing input
power.

Check the input power source.

Missing or
open fuses or
circuit breaker
tripped.

Check the fuses and circuit
breaker.

No power to
the LCP.

• Check the LCP cable for
proper connection or
damage.

• Replace any faulty LCP or
connection cables.

Incorrect
contrast
setting.

Press [Status] + [▲]/[▼] to

adjust the contrast.

Display is
defective.

Replace the faulty LCP or
connection cable.

Open power
fuses or circuit
breaker trip.

Phase-to-phase
short.

• Check the cabling.

• Check for loose
connections.

DC-link voltage
too high.

Brake resistor
not connected.

Check the brake resistor
cabling.

Brake resistor
too high
resistance.

Check if the lowest resistance
value has been entered.

Several servo
drives are
decelerating
with
insufficient
ramp time.

• Avoid simultaneous
deceleration of several
servo drives.

• Change the deceleration
speed of the servo drives.

Brake resistor
functionality
not activated.

Activate the brake function.

DC-link voltage
too low.

Incorrect mains
supply.

Check supply voltage matches
the allowed specification
detailed in chapter 8 ISD
Safety Concept.

DC overcurrent. The sum of the
servo drive
current exceeds
the maximum
rating of the
SAB.

• Check the servo drive
current consumption.

• Avoid simultaneous
acceleration of all servo
drives.

Fault Possible cause Possible solution

UAUX

overcurrent.
The servo
drives are
consuming
more power on
the UAUX line
than allowed.

• Check the number of
attached servo drives with
the shell diagrams in the

VLT®  Integrated Servo Drive

ISD®  510 System Design
Guide.

• Avoid simultaneous lifting
of the servo drive brakes.

UAUX

overvoltage.
Incorrect UAUX

supply.
Check that the supply
matches the allowed specifi-
cation detailed in
chapter 5.6 Auxiliary Supply
Requirements.

UAUX

undervoltage.
Incorrect UAUX

supply.
• Check that the supply

voltage matches the
allowed specification
detailed in
chapter 5.6 Auxiliary Supply
Requirements.

• Check that the output
power of the supply is
sufficient.

Mains phase
loss.

A phase is
missing on the
supply side, or
the voltage
imbalance is
too high.

Check the supply voltages and
supply currents to the SAB.

Grounding fault. Grounding
fault.

• Check for proper
grounding and loose
connections.

• Check the hybrid cables
for short circuits or
leakage currents.

Brake resistor
error.

Faulty brake
resistor.

Remove the power to the
SAB, wait for the discharge
time to elapse then replace
the brake resistor.

Brake chopper
error.

Faulty brake
chopper.

Check the setting in
parameter 2-15 Brake Check.

Table 9.3 Troubleshooting SAB
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9.3.2 Error Codes

Code Name Severity
(Warning/
error/trip
lock)

Description LCP name

0x0000 No error Error No error. –

0x1000 Generic application error Error Generic application error. generic err

0x2120 Ground fault Error There is current from the output
phases to ground.

ground fault

0x2340 Short circuit Error There is a short circuit in UDC output
from SAB (DC Line1 and/or DC Line2).
Remove power to the SAB and repair
the short circuit.

short circuit

0x2391 AUX 1 overcurrent Error Current on AUX Line 1 reached
overcurrent limit.

AUX1 overcurr

0x2392 AUX 2 overcurrent Error Current on AUX Line 2 reached
overcurrent limit.

AUX2 overcurr

0x2393 AUX 1 user limit current Warning,
error

Current on AUX Line 1 reached user-
defined limit.

AUX1 curr limit

0x2394 AUX 2 user limit current Warning,
error

Current on AUX Line 2 reached user-
defined limit.

AUX2 curr limit

0x2395 AUX 1 fuse failure Error HW fuse failure.
Current or voltage above limit on AUX
Line 1.

AUX1 fuse fail

0x2396 AUX 2 fuse failure Error HW fuse failure.
Current or voltage above limit on AUX
Line 2.

AUX2 fuse fail

0x2397 DC 1 overcurrent Error Overcurrent on DC Line 1. The SAB
peak current limit (approximately 200%
of the rated current) is exceeded.

DC1 overcurr

0x2398 DC 2 overcurrent Error Overcurrent on DC Line 2. The SAB
peak current limit (approximately 200%
of the rated current) is exceeded.

DC2 overcurr

0x2399 DC overcurrent Error Overcurrent. The SAB has reached the
current limit and shuts down to
prevent any damage to the hardware.

DC overcurr

0x239B Overload on output (I2T) Warning,
error

The SAB is about to cut out due to an
overload (more than 100% for too
long). The counter for electronic,
thermal SAB protection triggers a
warning at 90% and trips with an error
at 100%.

overload

0x239D DC overcurrent Warning,
error

Overcurrent. The SAB has reached the
current limit and shuts down to
prevent any damage to the hardware.

DC overcurr

0x3130 Mains phase loss Warning,
error

Mains phase loss detected. This occurs
when a phase on mains is missing, or
when the mains is imbalanced.

phase loss

0x3210 DC link overvoltage Error The DC-link voltage exceeds the limit
and the SAB trips.

UDC overvolt

0x3220 DC link undervoltage Error The DC-link voltage is below the limit
and the SAB trips.

UDC undervolt

0x3291 UAUX high voltage Warning UAUX above warning limit. UAUX high volt

0x3292 UAUX overvoltage Error UAUX above overvoltage limit. UAUX overvolt
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Code Name Severity
(Warning/
error/trip
lock)

Description LCP name

0x3293 UAUX low voltage Warning UAUX below warning limit. UAUX low volt

0x3294 UAUX undervoltage Error UAUX below undervoltage limit. UAUX undervolt

0x3295 UDC high voltage Warning The DC-link voltage (DC) is higher than
the high-voltage warning limit.

UDC high volt

0x3296 UDC low voltage Warning The DC-link voltage (DC) is lower than
the low-voltage warning limit.

UDC low volt

0x4220 Too low temperature: Heat
sink

Warning Heat sink temperature low. The SAB is
too cold to operate. This warning is
based on the temperature sensor in
the IGBT module. This warning only
occurs when DC-link voltage is >250 V.

low temp PM

0x4290 Overtemperature: Heat sink Warning,
Error

The maximum temperature of the heat
sink has been exceeded. The
temperature fault does not reset until
the temperature drops below a defined

heat sink temperature (115 °C).

overtemp PM

0x4291 Overtemperature: Control
card

Warning,
Error

Control card overtemperature.
The cutout temperature of the control

card is 80 °C.

overtemp CC

0x4292 Overtemperature: SAB card Warning,
Error

SAB card overtemperature.
The cutout temperature of the SAB

card is 80 °C.

overtemp SC

0x4293 Inrush overtemperature: SAB
card

Error Inrush fault. Too many transitions into
state Normal operation have occurred
within a short time period.

inrush SC

0x4294 Inrush overtemperature:
power module

Error Inrush fault. Too many power-ups have
occurred within a short time period.

inrush PM

0x4410 Overtemperature: SAB Error Logic OR of control card temperature
(see 0x4291) and/or heat sink
temperature (see 0x4290) and/or SAB
card temperature (see 0x4292).

overtemp SAB

0x6320 Parameter error Trip lock A parameter has an invalid value. param err

0x6380 Configuration error
(parameter missing)

Trip lock A parameter is missing. config err

0x6381 Reinitialization of parameters
from powercard

Trip lock Configuration reinitialization.
Configuration parameter for power unit
has been reinitialized.

config reinit

0x7111 Brake chopper short circuit Error The brake chopper is monitored during
operation. This error appears if a short
circuit occurs.

brake ch short

0x7181 Brake resistor failure Error The brake resistor is monitored during
operation. This error appears if a short
circuit occurs.

brake r short
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Code Name Severity
(Warning/
error/trip
lock)

Description LCP name

0x7182 Brake resistor power limit Error Brake resistor power limit exceeded.
The power transmitted to the brake
resistor is calculated as an average
value over the last 120 s of run time.
The calculation is based on the DC-link
voltage and the brake resistor value set
in parameter 2-16 (Brake resistor power
120 s). The error is reported when the
value is exceeded within 120 s.

brake r pwr lim

0x7183 Brake chopper check failed Error Brake check failed. The brake resistor is
not connected or not working.

brake ch check

0x7380 External position sensor error Error External encoder data could not be
read.

ext sensor err

0xFF21 Internal fan fault Warning Internal fan fault. The fan warning
function checks if the fan is running/
mounted.

fan fault

0xFF31 AUX Line 1 min off time Warning The minimum off time required to
protect the internal hardware has not
been met.

AUX1 min off

0xFF32 AUX Line 2 min off time Warning The minimum off time required to
protect the internal hardware has not
been met.

AUX2 min off

0xFF51 Internal error 1 Trip lock Internal error 1, contact Danfoss. PM int err 1

0xFF52 Internal error 2 Trip lock Internal error 2, contact Danfoss. PM int err 2

0xFF53 Internal error 3 Trip lock Internal error 3, contact Danfoss. PM int err 3

0xFF54 Internal error 4 Trip lock Internal error 4, contact Danfoss. PM int err 4

0xFF55 Internal error 5 Trip lock Internal error 5, contact Danfoss. PM int err 5

0xFF56 Internal error 6 Trip lock Internal error 6, contact Danfoss. PM int err 6

0xFF70 Firmware: Package description
mismatch

Trip lock Firmware found does not match
package description.

FW pack err

0xFF71 Firmware: Power cycle
needed

Warning,
error

Firmware update transfer is completed
but a power cycle is required before
the new firmware is active.

need powercycle

0xFF72 Firmware: Update started Warning,
error

Firmware update in progress. The
warning becomes an error when an
attempt is made to enable the drive in
this state.

FW update

Table 9.4 Error Codes for SAB
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10 Maintenance, Decommissioning, and Disposal

WARNING
HIGH VOLTAGE
Potentially lethal voltage is present on the connectors.
Before working on the power connectors (disconnecting
or connecting the cable), disconnect the SAB from the
mains and wait for the discharge time to elapse.

WARNING
DISCHARGE TIME
The servo drives and the SAB contain DC-link capacitors
that remain charged for some time after the mains
supply is switched off at the SAB. Failure to wait the
specified time after power has been removed before
performing service or repair work could result in death
or serious injury.

• To avoid electrical shock, fully disconnect the
SAB from the mains and wait for at least the
time listed in Table 10.1 for the capacitors to
fully discharge before carrying out any
maintenance or repair work on the ISD 510
servo system or its components.

Number Minimum waiting time (minutes)

0–64 servo drives 10

Table 10.1 Discharge Time

10.1 Maintenance Tasks

The servo drives are largely maintenance free. Only the
shaft seal (if used) is subject to wear.

The maintenance tasks listed in Table 10.2 can be
performed by qualified personnel (see chapter 2.5 Qualified
Personnel). No other tasks are required.

Component Maintenance
task

Maintenance
interval

Instruction

Servo drive Carry out a
visual
inspection.

Every 6
months

Check for any
abnormalities on the
surface of the servo
drive.

Shaft seal Check the
condition and
check for
leakage.

Every 6

months1)

If damaged, replace
the shaft seal.

Hybrid
cable

Check for
damage and
wear.

Every 6
months

If damaged or worn:
Replace the hybrid
cable (see
chapter 10.3.1 Cable
Replacement).

Mechanical
holding
brake
(optional)

Check the
brake.

Every 6
months

Ensure that the brake
can achieve the
holding torque as
detailed in
chapter 3.2.2.2 Brake
(Optional).

Functional
safety

Perform a
system power
cycle and
check the
STO function.

Every 12
months

Activate STO and
check the status with
the PLC. See
chapter 8 ISD Safety
Concept for further
information.

SAB Check the
fan.

Every 12
months

Check that the fan
can turn and remove
any dust or dirt.

Table 10.2 Overview of Maintenance Tasks

1) A shorter interval may be necessary depending on the application.
Contact Danfoss for more information.
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10.2 Inspection during Operation

Servo drives
Carry out regular inspections during operation. Check the
servo drives at regular intervals for anything unusual.

Pay particular attention to:
• Unusual noises.

• Overheated surfaces (temperatures up to 100 °C
can occur in normal operation).

• Uneven running.

• Strong vibrations.

• Loose fastenings.

• Condition of electrical wiring and cables.

• Poor heat dispersion.

If irregularities or problems occur, see chapter 9.2 Servo
Drive.

SAB
Carry out regular inspections during operation.

Ensure that:
• The cooling vents are not blocked.

• The fan is not making any unusual noises.

If irregularities or problems occur, see chapter 9.3 Servo
Access Box (SAB).

10.3 Repair

NOTICE
Always return defective equipment to the local Danfoss
sales company.

The repair tasks listed in this chapter can be performed by
qualified personnel (see chapter 2.5 Qualified Personnel).

10.3.1 Cable Replacement

Replace the cables when the rated number of bending
cycles has been reached or the cable is damaged.

NOTICE
Never disconnect or connect the cable from the servo
drive with the supply voltage connected. Doing so
damages the electronic circuitry. Observe the discharge
time for the DC-link capacitors.

NOTICE
Do not forcefully connect or fit the connectors. Incorrect
connection causes permanent damage to the connectors.

10.3.1.1 Feed-In Cable Replacement

Proceed as follows:

Disconnecting cables
1. Disconnect the SAB from its power source (mains

network and all auxiliary supplies).

2. Wait for the necessary discharge time to elapse.

3. Disconnect any cables connected to the X3, X4,
or X5 ports on the servo drive for easier access to
the feed-in cable.

4. Disconnect the PE wire from the decouping plate
on the SAB.

5. Open the cable clamp holding the STO cable.

6. Open the cable clamp holding the feed-in cable
on the SAB.

7. Loosen the feed-in cable connectors on the SAB.

8. Dismount the feed-in cable on the SAB.

9. Loosen the threaded ring of the connector on the
servo drive.

10. Disconnect the feed-in cable from the servo drive.

Cable replacement
Replace the feed-in cable with a cable of identical type
and length. See the VLT®  Integrated Servo Drive ISD®  510
System Design Guide for ordering numbers.

Connecting cables
1. Connect the female connector of the feed-in

cable to the male connector of the 1st servo
drive.

2. Turn the threaded rings of the connectors hand
tight.

3. Ensure that there is no mechanical tension on the
cables.

4. Insert the feed-in cable connectors into the
correct position on the SAB (see
chapter 5.8.1 Servo Access Box).

5. Secure the feed-in cable ensuring that the shield
is positioned exactly under the clamp.

6. Secure the STO cable in the cable clamp ensuring
that the shield is positioned exactly under the
clamp.

7. Connect the PE wire to the decoupling plate.

8. Reconnect any cables that were connected to the
X3, X4, or X5 ports.
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10.3.1.2 Loop Cable Replacement

Proceed as follows:

Disconnecting cables
1. Disconnect the SAB from its power source (mains

network).

2. Wait for the necessary discharge time to elapse.

3. Disconnect any cables connected to the X3, X4,
or X5 ports on both servo drives for easier access
to the loop cable.

4. Loosen the threaded rings of the loop cable
connectors on both servo drives.

5. Disconnect the loop cable from the servo drives.

Cable replacement
Replace the loop cable with a cable of identical type and
length. See the VLT®  Integrated Servo Drive ISD®  510 System
Design Guide for part numbers.

Connecting cables
1. Connect the male connector of the loop cable to

the female connector on the servo drive (see
chapter 5.8.2.1 Connecting/Disconnecting Hybrid
Cables).

2. Connect the female connector of the loop cable
to the male connector on the adjacent servo
drive (see chapter 5.8.2.1 Connecting/Disconnecting
Hybrid Cables).

3. Turn the threaded rings hand tight on both servo
drives.

4. Ensure that there is no mechanical tension on the
cables.

5. Tighten the threaded rings of the connectors on
both servo drives.

6. Reconnect any cables that were connected to the
X3, X4, or X5 ports on both servo drives.

10.4 Servo Drive Replacement

10.4.1 Dismounting

The procedure for dismounting the servo drive is the
reverse of the fitting procedure described in chapter
chapter 5 Electrical Installation.

Proceed as follows:
1. Disconnect the supply and wait for the discharge

time to elapse.

2. Disconnect the electrical cables.

3. Dismount the servo drive.

4. Replace the ISD 510 servo drive with an ISD 510
servo drive of the same type. See the VLT®

Integrated Servo Drive ISD®  510 System Design
Guide for part numbers.

10.4.2 Fitting and Commissioning

The procedure for fitting and commissioning the servo
drive is described in chapter 4.5.3 Fitting Instructions Servo
Drive and chapter 6 Commissioning.

Proceed as follows:
1. Check if preparation is required (see

chapter 4.4.1 Servo Drive).

2. Fit the servo drive (see chapter 4.5.3 Fitting
Instructions Servo Drive).

3. Connect the hybrid cables (see
chapter 5.8.2.1 Connecting/Disconnecting Hybrid
Cables).

4. Connect the I/O and/or encoder cables (see
chapter 5.8.2.2 Connecting/Disconnecting Cables
from Ports X3, X4, and X5).

5. Configure the servo drive parameters according
to the fieldbus used (see chapter 6.2 ID
Assignment).

6. Conduct a test run.

10.5 SAB Replacement

10.5.1 Dismounting

The procedure for dismounting the SAB is as follows:
1. Disconnect the supply and wait for the discharge

time to elapse.

2. Disconnect the electrical cables.

3. Remove the decoupling plate.

4. Dismount the SAB.

10.5.2 Fitting and Commissioning

The procedure for fitting and commissioning the SAB is
described in chapter 4.5.5 Fitting Instructions Servo Access
Box (SAB) and chapter 6 Commissioning.

Proceed as follows:
1. Check if preparation is required (see

chapter 4.4.2 Servo Access Box (SAB)).

2. Fit the SAB as described in chapter 4.5.5 Fitting
Instructions Servo Access Box (SAB).

3. Connect the electrical cables as described in
chapter 5.8.1 Servo Access Box.

4. Switch on the system as described in
chapter 6.3 Switching on the ISD 510 Servo System.

5. Configure the SAB parameters according to the
fieldbus used (see chapter 6.2 ID Assignment).

6. Conduct a test run.
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10.6 Decommissioning of the ISD 510 Servo
System

The procedure for decommissioning the servo system is
the reverse of the installation procedure described in
chapter 4 Mechanical Installation.

Proceed as follows:
1. Disconnect all supplies to the servo system and

wait for the discharge time to elapse.

2. Disconnect the electrical cables.

3. Dismount the servo drive.

4. Dismount the SAB.

10.7 Product Returns

Danfoss products can be returned for disposal at no
charge. A prerequisite for this is that they are free of
deposits, such as oil, grease, or other types of contami-
nation that hamper disposal.
Furthermore, foreign materials or third-party components
cannot be included with the returned product.
Ship the products free on board to the local Danfoss sales
company.

10.8 Recycling and Disposal

10.8.1 Recycling

Take metals and plastics to recycling stations.

The entire servo drive and the SAB are classified as
electronic waste, and the packaging is classified as
packaging waste.

10.8.2 Disposal

Devices containing electronic components cannot be
disposed of as normal domestic waste.

Dispose of the servo drives and the SAB as hazardous
waste, electrical waste, recyclable waste, and so on, in
accordance with applicable local regulations.
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11 Specifications

11.1 Servo Drive

11.1.1 Nameplate

Check the nameplate and compare it with the order data.
Use the part number for reference.
The part number uniquely identifies the drive type (see
chapter 3.2.1.1 Types).
Ensure that the nameplate is clearly legible.
The servo drives can be identified externally only by the
original Danfoss nameplate.
The following data is shown on the servo drive nameplate:

13
0B

E6
13

.1
0

VLT ISD 510

Input1: 560-680VDC 1.4A   Input2: 24-48VDC 0.3A

Ambient: 5˚ ... 40˚C/41˚ ... 104˚F
Enclosure: IP54

PART NO: 000G0000 SERIAL NO: 000000M000

000G0000000000M000
Made in Germany

UL xxxxx

M   : 2.6Nm  n   : 3000rpm  P   : 800WN NN

M       : 10.5Nm  n      : 3800rpm    M   : 3.5Nmmax 0max

ISD510AT01C9D6E54FRXECSXXTF084SXN40XSXSX
1

2

4
3

5
6

7

8
9

10
11

1 Typecode 7 UAUX supply

2 Supply voltage 8 Rated power

3 Rated torque 9 Standstill torque

4 Maximum torque 10 Rated speed

5 Ambient temperature range 11 Maximum speed

6 Protection rating – –

Illustration 11.1 Servo Drive Nameplate

11.1.2 Characteristic Data

Table 11.1 and Table 11.2 provide a summary of typical servo drive characteristics.

Specifications Unit Size 1
1.5 Nm

Size 2
2.1 Nm

Size 2
2.9 Nm

Size 2
3.8 Nm

Rated speed nN RPM 4600 4000 2900 2400

Rated torque MN Nm 1.5 2.1 2.9 3.8

Rated current IN A DC 1.4 1.7 1.8

Rated power PN kW 0.72 0.88 0.94

Standstill (Stall)
torque M0

Nm 2.3 2.8 3.6 4.6

Standstill (Stall)
current I0

A DC 2.1 2.3 2.1 2.2

Peak torque Mmax Nm 6.1 7.8 10.7 12.7

Peak current (rms
value) Imax

A DC 5.7 6.4

Rated Voltage V DC 560/680

Inductance L 2ph mH 18.5 26.8 32.6 33.9

Resistance R 2ph Ω 9.01 7.78 8.61 8.64

Voltage constant
EMK

V/krms 70.6 80.9 111.0 132.0

Torque constant Kt Nm/A 1.10 1.26 1.72 2.04

Inertia kgm2 0.000085 0.00015 0.00021 0.00027

Shaft diameter mm 14 19
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Specifications Unit Size 1
1.5 Nm

Size 2
2.1 Nm

Size 2
2.9 Nm

Size 2
3.8 Nm

Pole pairs – 4 5

Flange size mm 76 84

Weight kg 3.5 4.0 5.0 6.0

Table 11.1 Characteristic Data for Servo Drive without Brake

Specifications Unit Size 1
1.5 Nm

Size 2
2.1 Nm

Size 2
2.9 Nm

Size 2
3.8 Nm

Brake inertia kgm2 0.0000012 0.0000068 0.0000068 0.0000068

Brake weight kg 0.34 0.63

Rated torque
derating

% 8 6 7

Table 11.2 Characteristic Data for Servo Drive with Brake

11.1.3 Dimensions

Flange

Servo drive Flange thickness

Size 1, 1.5 Nm 7 mm

Size 2, 2.1 Nm –

Size 2, 2.9 Nm 8 mm

Size 2, 3.8 Nm 8 mm

Table 11.3 Flange Thickness

All dimensions are in mm (in).
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Illustration 11.2 Dimensions of ISD 510 Size 1, 1.5 Nm
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Illustration 11.3 Dimensions of ISD 510 Size 2, 2.1 Nm
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Illustration 11.4 Dimensions of ISD 510 Size 2, 2.9 Nm
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Illustration 11.5 Dimensions of ISD 510 Size 2, 3.8 Nm
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11.1.4 Permitted Forces

20

Fa
Fr
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Illustration 11.6 Permitted Forces

Illustration 11.6 shows the maximum permitted forces on
the motor shaft.

The maximum axial and radial load while assembling the
motor and for any mechanical device connected to the
shaft, must not exceed the values shown in Table 11.4. The
shaft must be loaded slowly and in a constant manner:
Avoid pulsating loads.

See the VLT®  Integrated Servo Drive ISD®  510 System Design
Guide for bearing load curves.

NOTICE
The bearing could be permanently damaged if the
maximum permitted forces are exceeded.

Motor size Radial Force (Fr) in N Axial Force (Fa) in N

Size 1 450 1050

Size 2 900 1700

Table 11.4 Permitted Forces

11.1.5 General Specifications and
Environmental Conditions

Vibration test Random vibration: 7.54 g (2h/axis according
to EN 60068-2-64)
Sinusoidal vibration: 0.7 g (2h/axis
according to EN 60068-2-6)

Maximum relative
humidity

Storage/transport: 5–93% (non-condensing)
Stationary use: 15–85% (non-condensing)

Ambient
temperature range

5–40 °C above derating, maximum 55 °C
(24-hour average maximum 35 °C)

Transport: -25 to +70 °C
Storage: -25 to +55 °C

Installation
elevation

Maximum 1000 m above sea level

EMC standard for
emission and
immunity

EN 61800-3

Table 11.5 General Specifications and Environmental Conditions
for Servo Drive

Protection ratings

13
0B

E7
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IM B5 IM V1 IM V3

Illustration 11.7 Mounting Positions

 Mounting position of
servo drive
(according to DIN 42 950)

IP rating
(according to
EN 60529)

Housing All positions IP67

Shaft without shaft
seal

IM B5 & IM V1 IP54

IM V3 IP50

Shaft with shaft
seal

IM B5 & IM V1 IP65

IM V3 IP60

Table 11.6 Protection Ratings
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11.2 Servo Access Box

11.2.1 Nameplate

The following data is shown on the SAB nameplate:

13
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VLT Servo Access Box

P   : 8.47KW(400V) / 10.18KW(480V)
Input: 3x400-480V 50/60Hz 12.5A
Output: 565VDC - 679VDC / 15A
Ambient: 50˚C/122˚F  Enclosure: IP20

PART NO: 000X0000 SERIAL NO: 000000M000

000X00000000000M000
Made in Germany

UL xxxxx

CAUTION:

WARNING:

See manual for special condition/mains fuse
Voir manuel de conditions spéciales/fusibles

Stored charge, wait 10 min.
Charge residuélle, attendez 10 min.

N

1
2
3
4 5

1 Rated power 4 Ambient temperature

2 Supply voltage 5 Protection rating

3 Output voltage – –

Illustration 11.8 SAB Nameplate

Ensure that the nameplate is clearly legible.

11.2.2 Characteristic Data

Definition Value and unit

Input

Input voltage 400–480 V ±10%

Efficiency 98.5% at 400 V

Input current 12.5 A continuous
20 A intermittent

Output

Output voltage
ISD Line 1: UDC 1 & ISD Line 2: UDC 2

565–679 V ±10%2)

Output voltage
ISD Line 1: STO 1 & ISD Line 2: STO 2

24 V ±10%

Output voltage
ISD Line 1: AUX 1 & ISD Line 2: AUX 2

24–48 V ±10%

Output current
ISD Line 1: AUX 1 & ISD Line 2: AUX 2

15 A

Output current UDC 15 A

Output current
ISD Line 1: STO 1 & ISD Line 2: STO 2

1 A1)

Output power 8.47–10.18 kW2)

Housing

Dimensions (W x H x D) 130 x 268 x 80 mm

Weight 8.3 kg

Table 11.7 Servo Access Box Characteristic Data

1) Depends on the number of servo drives connected in the
application. The current per drive is 6.7 mA

2) Depends on the input voltage.
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11.2.3 Dimensions

All dimensions are in mm (in).

Front view
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Illustration 11.9 Dimensions: Front View
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Side view
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Illustration 11.10 Dimensions: Side View
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11.2.4 General Specifications and
Environmental Conditions

Protection rating IP20

Vibration test Random vibration: 1.14 g (2h/axis
according to EN 60068-2-64)
Sinusoidal vibration: 0.7 g (2h/axis
according to EN 60068-2-6)

Maximum relative
humidity

Storage/transport and stationary use:
5–93% (non-condensing)

Ambient
temperature range

5–50 °C operating temperature

(24 hour average maximum 45 °C)

Transport: -25 to +70 °C
Storage: -25 to +55 °C

Installation elevation Maximum 1000 m above sea level

EMC standard for
emission and
immunity

EN 61800-3

Table 11.8 General Specifications and Environmental Conditions
SAB

11.3 Cables

NOTICE
See the VLT®  Integrated Servo Drive ISD®  510 System
Design Guide for cable dimensions and drawings.

All cables supplied by Danfoss have a nameplate as per
the example in Illustration 11.11.
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4
5
6
7
8

9

10

Danfoss ISD 510 Hybrid xxxx Cable

Length: xxxx

Ordering no. 175Gxxxx Rev. x.

1 7 5 G 8 9 X X

Speci�cation no. 175Rxxxx Rev. xxx.

Signal rating Ethernet: 2 x 2 x AWG24 300V

yy.mm.dd

Power rating: 5 x 2.5mm    1000V 18A2

Signal rating: 2 x 0.5mm     300V 2

1 Cable type

2 Ordering code

3 Revision of specification

4 Manufacturing date

5 Length

6 Power rating

7 Signal rating

8 Signal rating for Ethernet

9 Barcode

10 Manufacturer logo

Illustration 11.11 Example of a Cable Nameplate

11.4 Storage

Store the servo drives and the SAB in a dry, dust-free
location with low vibration (veff ≤0.2 mm/s).
Do not store the packaged system components on top of
each other.
The storage location must be free from corrosive gases.
Avoid sudden temperature changes.

11.4.1 Long-Term Storage

NOTICE
To recondition the electrolytic capacitors, servo drives
and SABs not in service must be connected to a supply
source once per year to allow the capacitors to charge
and discharge. Otherwise the capacitors could suffer
permanent damage.
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12 Appendix

12.1 Glossary

A flange
The A side is the shaft side of the servomotor.

Ambient temperature
The temperature in the immediate vicinity of the servo
system or component.

Automation Studio™
Automation Studio™ is a registered trademark of B&R. It is
the integrated software development environment for B&R
controllers.

Axial force
The force in newton-metres acting on the rotor axis in the
axial direction.

Bearings
The ball bearings of the servomotor.

Beckhoff®

Beckhoff® is a registered trademark of and licensed by
Beckhoff Automation GmbH, Germany.

B&R
Multi-national company, specialising in factory and process
automation software and systems for a wide range of
industrial applications.

B side
The rear side of the servo drive with the plug-and-socket
connectors.

Brake
Mechanical holding brake on the servo drive.

CANopen®

CANopen® is a registered community trademark of CAN in
Automation e.V.

CE
European test and certification mark.

CiA DS 402
Device profile for drives and motion control.
CiA® is a registered community trademark of CAN in
Automation e.V.

Clamping set
A mechanical device, which, for example, can be used to
secure gears to a motor shaft.

Connector (M23)
Servo drive hybrid connector.

Cooling
ISD servo drives are cooled by convection (without fans).

DC-link
Each servo drive has its own DC-link, consisting of
capacitors.

DC-link voltage
A DC voltage shared by several servo drives connected in
parallel.

DC voltage
A direct constant voltage.

EPSG
Ethernet POWERLINK® Standardization Group.

ETG
EtherCAT® Technology Group

EtherCAT®

EtherCAT® (Ethernet for Control Automation Technology) is
an open high performance Ethernet-based fieldbus system.
EtherCAT® is a registered trademark and patented
technology, licensed by Beckhoff Automation GmbH,
Germany.

Illustration 12.1 EtherCAT® Logo

Ethernet POWERLINK®

Ethernet POWERLINK® is a deterministic real-time protocol
for standard Ethernet. It is an open protocol managed by
the Ethernet POWERLINK® Standardization Group (EPSG). It
was introduced by Austrian automation company B&R in
2001.

Feed-in cable
Hybrid connection cable between the SAB and servo drive.

Feedback system
Feedback systems for servo drives in general.

Fieldbus
Communication bus between controller and servo axis and
SAB; in general between controller and field nodes.

Firmware
Software in the unit; runs on the control board.

Function block
Device functionalities are accessible via the engineering
environment software.

IGBT
The insulated-gate bipolar transistor is a 3 terminal
semiconductor device, primarily used as an electronic
switch to combine high efficiency and fast switching.

Installation elevation
Installation elevation above normal sea level, typically
associated with a derating factor.

ISD
Integrated servo drive.
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ISD devices
Refers to both the ISD 510 servo drives and the SAB.

ISD servomotor
Designates the ISD servomotor (without the drive
electronics).

ISD Toolbox
A Danfoss PC software tool used for parameter setting and
diagnostics of ISD servo drives and the SAB.

LCP
Local control panel.

Loop cable
Hybrid connection cable between 2 servo drives, with 2
M23 connectors.

M8 connectors
Fully functional real-time Ethernet port (X3) on the B side
of the advanced servo drive.
Connector (X5) for connection of the LCP to the B side of
the advanced servo drive.

M12 connector
Connector (X4) for connecting I/O and/or encoder on the B
side of the advanced servo drive.

M23 connectors
Connectors (X1 & X2) for connecting the hybrid feed-in
and loop cables on the B side of the standard and
advanced servo drive.

Motor shaft
Rotating shaft on the A side of the servo motor, typically
without a key groove.

Multi-turn encoder
Describes a digital absolute encoder, in which the absolute
position remains known after several revolutions.

PLC
A programmable logic controller is a digital computer used
for automation of electromechanical processes, such as
control of machinery on factor assembly lines.

PELV
Protected extra low voltage. Low voltage directive
regarding voltage levels and distances between lines.

PLCopen®

The name PLCopen® is a registered trademark and,
together with the PLCopen® logos, is owned by the
association PLCopen®. PLCopen® is a vendor- and product-
independent worldwide association, which defines a
standard for industrial control programming.

POU
Program organization unit. This can be a program, function
block, or function.

PWM
Pulse width modulation.

Radial force
The force in newton-metres acting at 90° to the
longitudinal direction of the rotor axis.

RCCB
Residual current circuit breaker.

Resolver
A feedback device for servomotors, typically with 2 analog
tracks (sine and cosine).

Safety (STO)
A servo drive safety circuit that switches off the voltages of
the driver components for the IGBTs.

Scope
Is part of the ISD Toolbox software and is used for
diagnosis. It enables internal signals to be depicted.

Servo Access Box (SAB)
Generates the DC-link supply for the ISD 510 servo system
and can host up to 64 servo drives.

SIL 2
Safety Integrated Level II.

Single-turn encoder
Describes a digital absolute encoder, in which the absolute
position for 1 revolution remains known.

SSI
Synchronous serial interface.

STO
Safe Torque Off function. On activation of STO, the servo
drive is no longer able to produce torque in the motor.

TwinCAT®

TwinCAT® is a registered trademark of and licensed by
Beckhoff Automation GmbH, Germany. It is the integrated
software development environment for controllers from
Beckhoff.

UAUX

Auxiliary supply, provides power to the control electronics
of the drives and SAB.

Wireshark®

Wireshark® is a network protocol analyzer released under
the GNU General Public License version 2.
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Housing....................................................................................................  89
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